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MEANINGFUL USE STAGE 2 INTRODUCTION

This guide contains scenario-based examples of the workflow needed to become compliant for Meaningful Use 
Stage 2 measures.  Some of the most common scenarios are outlined here, although the methods used may not 
always be the only way to complete a given task.

The Final Rule Meaningful Use objectives are split into three groups:

 Core Objectives - These 17 objectives must all be satisfied in to fulfill the Meaningful Use requirements.

 Menu Set Objectives - Providers can select three (3) out of these six (6) objectives that they wish to satisfy 
to fulfill the Meaningful Use requirements.

 Clinical Quality Measures - Formerly a Core Measure, it has been removed as redundant, but providers are 
still required to report on Clinical Quality Measures to achieve Meaningful Use.  Beginning in 2014, eligible 
professionals must select and report on nine (9) of a possible list of 64 approved CQMs for the EHR 
Incentive Programs.  There is also a new requirement in 2014 that the CQMs selected must cover at least 
three (3) of the six (6) available National Quality Strategy (NQS) domains

The recommended methods of satisfying Meaningful Use measures are detailed in this guide, but there may be 
other methods of satisfying certain measures using the eClinicalWorks EMR/PM system.  For more information 
on all features available when using eClinicalWorks, refer to the HelpHub, which can be accessed from within 
the eClinicalWorks application at: Help > HelpHub.

Certain Visit Types, Visit Statuses, and patients are excluded from all Meaningful Use calculations.  For more 
information on the processes related to excluding visits, statuses, and patients, refer to the following sections:

 Excluding Visit Types from Meaningful Use Calculations

 Excluding Visit Statuses from Meaningful Use Calculations

 Excluding Inactive and Deceased Patients from Meaningful Use Calculations

Note:  It is required that the technology certified for 2014 is used to satisfy these measures.  Version 10 
of eClinicalWorks is the 2014 certified technology.

Note:  While there are exclusions provided for some of the Menu Set objectives, users cannot select 
one of these objectives and claim the exclusion if there are other Menu Set objectives that they can 
report on instead.

IMPORTANT!  There are two types of measures: percentage-based and self-attest.  Self-attest measures 
require users to meet the criteria and report with a Yes or No while percentage-based measures require 
calculations to determine the numerator and denominator.  The MAQ Dashboards are a reporting tool 
that can be used to determine how well you are satisfying the percentage based Meaningful Use 
measures with eClinicalWorks.

Note:  Visit Type and Visit Status exclusions only affect Core and Menu Set objective measures and 
not Clinical Quality Measures.
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MEANINGFUL USE STAGE 2 INTRODUCTION EXCLUDING VISIT TYPES FROM MEANINGFUL USE CALCULATIONS
Excluding Visit Types from Meaningful Use 
Calculations

Certain visit types can be automatically excluded from Meaningful Use calculations.  Any visits with these visit 
types are ignored by the system when calculating compliance percentages for all measures.

To exclude visit types from Meaningful Use calculations:

1. From the Admin band in the left navigation pane, click Admin.

The Admin login window opens.

2. Enter your administrator password and click Login.

The Admin window opens.

3. Click the User Admin folder in the left pane.

The items in the User Admin folder display in the left pane.

4. Click Visit Type Codes in the left pane.

The Visit Type Codes options display in the right pane.

5. Click Add.

The Visit Codes options display in the right pane.

IMPORTANT!  If providers are seeing patients using a visit type, then it should not be excluded from 
reporting.
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MEANINGFUL USE STAGE 2 INTRODUCTION EXCLUDING VISIT TYPES FROM MEANINGFUL USE CALCULATIONS
6. Check the Exclude from Meaningful Use Reporting box:

7. Enter any remaining information here as appropriate.

8. Click Save.

This new Visit Type is created.  Any encounter using this Visit Type is not included in the calculations for any 
Meaningful Use measure.
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 10



MEANINGFUL USE STAGE 2 INTRODUCTION EXCLUDING VISIT STATUSES FROM MEANINGFUL USE CALCULATIONS
Excluding Visit Statuses from Meaningful Use 
Calculations

Certain visit statuses can be automatically excluded from Meaningful Use calculations.  Any visits with these 
visit statuses are ignored by the system when calculating compliance percentages for all measures.

To exclude visit statuses from Meaningful Use calculations:

1. From the Admin band in the left navigation pane, click Admin.

The Admin login window opens.

2. Enter your administrator password and click Login.

The Admin window opens.

3. Click the User Admin folder in the left pane.

The items in the User Admin folder display in the left pane.

4. Click Visit Status Codes in the left pane.

The Visit Status Codes options display in the right pane.

5. Click Add.

The Visit Codes options display in the right pane.

6. Check the Exclude from Meaningful Use Reporting box:

7. Enter the rest of the information here as appropriate.

8. Click Save.

This new Visit Status is created.  Any encounter using this Visit Status is not included in the calculations for 
any Meaningful Use measure.
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MEANINGFUL USE STAGE 2 INTRODUCTION EXCLUDING INACTIVE AND DECEASED PATIENTS FROM MEANINGFUL USE CALCULATIONS
Excluding Inactive and Deceased Patients from 
Meaningful Use Calculations

Any patients that are marked as Inactive or Deceased are excluded from Meaningful Use calculations.

Marking a Patient as Inactive

Patients that no longer go to your practice may be marked as Inactive from the Patient Information window.

To mark a patient as Inactive:

1. Click the Patient Lookup icon at the top of the application.

The Patient Lookup window opens.

2. Search for and highlight the inactive patient, then click Patient Info.

The Patient Information window opens.

3. Click Additional Info.

The additional Patient Information window opens.

4. Check the Inactive box:

5. Click OK.
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MEANINGFUL USE STAGE 2 INTRODUCTION EXCLUDING INACTIVE AND DECEASED PATIENTS FROM MEANINGFUL USE CALCULATIONS
The additional Patient Information window closes.

6. Click OK.

The Patient Information window closes and this patient is marked Inactive.

Marking a Patient as Deceased

Deceased patients may be marked as such from the Patient Information window.

To mark a patient as deceased:

1. Click the Patient Lookup icon at the top of the application.

The Patient Lookup window opens.

2. Search for and highlight the inactive patient, then click Patient Info.

The Patient Information window opens.

3. Click Additional Info.

The additional Patient Information window opens.

4. Check the Deceased box.

The Date and Notes fields display in the Deceased section:
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MEANINGFUL USE STAGE 2 INTRODUCTION REQUESTING A DIRECT ADDRESS
5. Enter the date this patient died in the Date field (in mm/dd/yyyy format).

6. Enter any applicable notes concerning this patient’s death (such as the manner) in the Notes field.

7. Click OK.

The additional Patient Information window closes.

8. Click OK.

The Patient Information window closes and this patient is marked Deceased.

Requesting a Direct Address
A Direct Address is required for practices to electronically transmit clinical information to a third party.  This is 
necessary to satisfy aspects of Core Measure 15, and can also optionally be used for Core Measure 7.

To request a Direct Address:

1. From the Admin band, click eCW P2P Admin:

The P2P Admin window opens.

2. If you are already on Join the Network (JTN), click Edit Settings:

Note: Non-eCW providers can go to  http://www.jointhenetwork.com to request an eClinicalWorks-
issued Direct Address.
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MEANINGFUL USE STAGE 2 INTRODUCTION REQUESTING A DIRECT ADDRESS
If you are not yet on JTN, click Register to Join the Network.

The P2P Account Settings window opens.

3. In the HISP - Direct section, enter all applicable information:

4. Click Check Availability.

The availability of your organization name is checked against the database.  If your chosen name is 
unavailable, change it and click Check Availability again until Address Available displays:
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MEANINGFUL USE STAGE 2 INTRODUCTION REQUESTING A DIRECT ADDRESS
5. Click Submit:

The HISP - Direct status is marked as Pending.  A Direct Address is issued within five (5) business days.  
Once issued, the HISP-Direct status is marked as Confirmed.
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CORE MEASURES

All 17 of these objectives must be satisfied in order to fulfill the Meaningful Use requirements.

The following objectives are Core Measures:

 Core 1: Using CPOE for Medication, Laboratory, and Radiology Orders

 Core 2: Generating and Transmitting e-Prescriptions

 Core 3: Recording Demographics

 Core 4: Recording Vital Signs

 Core 5: Recording Smoking Status

 Core 6: Clinical Decision Support Rule

 Core 7: Patient Electronic Access

 Core 8: Providing Clinical Summaries

 Core 9: Protect Electronic Health Information

 Core 10: Incorporating Lab Test Results as Structured Data

 Core 11: Patient Lists

 Core 12: Preventive Care

 Core 13: Patient-Specific Education Resources

 Core 14: Medication Reconciliation

 Core 15: Summary of Care

 Core 16: Submitting Electronic Data to Immunization Registries

 Core 17: Use Secure Electronic Messaging

Note: For more information on all features referenced in this guide, refer to the HelpHub, which can be 
accessed from within the eClinicalWorks application from the Help menu.
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Core 1: Using CPOE for Medication, Laboratory, and 
Radiology Orders

Objective

Use computerized provider order entry (CPOE) for medication, laboratory and radiology orders directly entered 
by any licensed healthcare professional who can enter orders into the medical record per state, local and 
professional guidelines. 

Measure

More than 60 percent of medication, 30 percent of laboratory, and 30 percent of radiology orders created by 
the EP during the EHR reporting period are recorded using CPOE.

Core 1-1

Denominator

Medications are included in the denominator if they satisfy the following criteria:

IMPORTANT! To restrict non-licensed healthcare professionals from entering orders on your behalf, 
ensure that the security setting Treatment - Allows access to the treatment plan from Progress Notes is 
unchecked for those non-licensed users. This restricts their access to the Treatment section on the 
Progress Notes.

Denominator Criteria Area to Document within eClinicalWorks

They have been created with a 
Start status by an EP or a member 
of the EP’s staff during the 
reporting period. 

Record this information from the following locations:
 Progress Notes > Treatment > Add
 Telephone/Web Encounter > Rx tab > Select Rx
 Telephone/Web Encounter > Virtual Visit tab > Treatment > Add

Note:  CPOE involves all methods of recording medications in a 
structured manner. This includes any use of Order Sets, Templates, e-
Prescription, eCliniSense, and any other methods of manually 
ordering medications on the Treatment window of Progress Notes or 
the Rx tab/Virtual Visit Treatment section of a Telephone/Web 
Encounter
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Numerator

Medications that satisfy the denominator are included in the numerator if they satisfy the following criteria:

Exclusion

Providers may be excluded from this measure if they meet the following criteria: 

Features Related to Core 1-1

The following features are related to satisfying Core Measure 1-1:

 Recording Medications

 Setting Up Staff Members as Licensed Healthcare Professionals/Credentialed Medical Assistants

Numerator Criteria Area to Document within eClinicalWorks

They have been entered by a 
licensed healthcare professional or 
credentialed medical assistant. 

Record this information from the following locations:
 Admin > Staff > select staff member > check the Licensed 

Medical Professional or Credentialed Medical Assistant box
 Progress Notes > Treatment > Add
 Telephone/Web Encounter > Rx tab > Select Rx
 Telephone/Web Encounter > Virtual Visit tab > Treatment > Add

Exclusion Criteria Area to Document within eClinicalWorks

They have ordered less than 100 
medications during the reporting 
period.

This exclusion criteria is reported by self-attestation.
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 19



CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Recording Medications

 Progress Notes > Treatment > Add

 Telephone/Web Encounter > Rx tab > Select Rx
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
 Telephone/Web Encounter > Virtual Visit tab > Treatment > Add
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Setting Up Staff Members as Licensed Healthcare Professionals/

Credentialed Medical Assistants

This is a one-time setup that must be performed for each staff member that will be recording medications in 
the system:

 Admin > Staff > select staff member > check the Licensed Medical Professional or Credentialed Medical 
Assistant box

Core 1-2

Denominator

Diagnostic Imaging orders are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have been created by an EP or 
a member of the EP’s staff during 
the reporting period.

Record this information from the following locations:
 Progress Notes > Diagnostic Imaging
 Progress Notes > Treatment > Browse in the Diagnostic Imaging 

section
 Telephone/Web Encounter > Labs/DI tab > select Imaging from 

drop-down list > New
 Telephone/Web Encounter > Virtual Visit tab > Diagnostic 

Imaging
 Telephone/Web Encounter > Virtual Visit tab > Treatment > 

Browse in the Diagnostic Imaging section
 Patient Hub > DI > New
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Numerator

Diagnostic Imaging orders that satisfy the denominator are included in the numerator if they satisfy the 
following criteria:

Exclusion

Providers may be excluded from this measure if they meet the following criteria: 

Features Related to Core 1-2

The following features are related to satisfying Core Measure 1-2:

 Recording Diagnostic Imaging Orders

 Setting Up Staff Members as Licensed Healthcare Professionals/Credentialed Medical Assistants

Numerator Criteria Area to Document within eClinicalWorks

They have been entered by a 
licensed healthcare professional or 
credentialed medical assistant.

Record this information from the following locations:
 Admin > Staff > select staff member > check the Licensed 

Medical Professional or Credentialed Medical Assistant box
 Progress Notes > Diagnostic Imaging
 Progress Notes > Treatment > Browse in the Diagnostic Imaging 

section
 Telephone/Web Encounter > Labs/DI tab > select Imaging from 

drop-down list > New
 Telephone/Web Encounter > Virtual Visit tab > Diagnostic 

Imaging
 Telephone/Web Encounter > Virtual Visit tab > Treatment > 

Browse in the Diagnostic Imaging section
 Patient Hub > DI > New

Exclusion Criteria Area to Document within eClinicalWorks

They have ordered less than 100 
diagnostic imaging orders during 
the reporting period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Recording Diagnostic Imaging Orders

 Progress Notes > Diagnostic Imaging

 Progress Notes > Treatment > Browse in the Diagnostic Imaging section
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
 Telephone/Web Encounter > Labs/DI tab > select Imaging from drop-down list > New

 Telephone/Web Encounter > Virtual Visit tab > Diagnostic Imaging
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
 Telephone/Web Encounter > Virtual Visit tab > Treatment > Browse in the Diagnostic Imaging section

 Patient Hub > DI > New
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Setting Up Staff Members as Licensed Healthcare Professionals/

Credentialed Medical Assistants

This is a one-time setup that must be performed for each staff member that will be recording medications in 
the system:

 Admin > Staff > select staff member > check the Licensed Medical Professional or Credentialed Medical 
Assistant box

Core 1-3

Denominator

Lab orders are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have been created by an EP or 
a member of the EP’s staff during 
the reporting period.

Record this information from the following locations:
 Progress Notes > Lab Reports
 Progress Notes > Treatment > Browse in the Labs section
 Telephone/Web Encounter > Labs/DI tab > select Labs from 

drop-down list > New
 Telephone/Web Encounter > Virtual Visit tab > Lab Reports
 Telephone/Web Encounter > Virtual Visit tab > Treatment > 

Browse in the Labs section
 Patient Hub > Labs > New
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Numerator

Lab orders that satisfy the denominator are included in the numerator if they satisfy the following criteria:

Exclusion

Providers may be excluded from this measure if they meet the following criteria: 

Features Related to Core 1-3

The following features are related to satisfying Core Measure 1-3:

 Recording Labs

 Setting Up Staff Members as Licensed Healthcare Professionals/Credentialed Medical Assistants

Numerator Criteria Area to Document within eClinicalWorks

They have been entered by a 
licensed healthcare professional or 
credentialed medical assistant.

Record this information from the following locations:
 Admin > Staff > select staff member > check the Licensed 

Medical Professional or Credentialed Medical Assistant box
 Progress Notes > Lab Reports
 Progress Notes > Treatment > Browse in the Labs section
 Telephone/Web Encounter > Labs/DI tab > select Labs from 

drop-down list > New
 Telephone/Web Encounter > Virtual Visit tab > Lab Reports
 Telephone/Web Encounter > Virtual Visit tab > Treatment > 

Browse in the Labs section
 Patient Hub > Labs > New

Exclusion Criteria Area to Document within eClinicalWorks

They have ordered less than 100 
lab orders during the reporting 
period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
Recording Labs

 Progress Notes > Lab Reports

 Progress Notes > Treatment > Browse in the Labs section
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
 Telephone/Web Encounter > Labs/DI tab > select Labs from drop-down list > New

 Telephone/Web Encounter > Virtual Visit tab > Lab Reports
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CORE MEASURES CORE 1: USING CPOE FOR MEDICATION, LABORATORY, AND RADIOLOGY ORDERS
 Telephone/Web Encounter > Virtual Visit tab > Treatment > Browse in the Labs section

 Patient Hub > Labs > New
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
Setting Up Staff Members as Licensed Healthcare Professionals/

Credentialed Medical Assistants

This is a one-time setup that must be performed for each staff member that will be recording medications in 
the system:

 Admin > Staff > select staff member > check the Licensed Medical Professional or Credentialed Medical 
Assistant box

Core 2: Generating and Transmitting e-Prescriptions

Objective

Generate and transmit permissible prescriptions electronically (eRx). 

Measure

More than 50 percent of all permissible prescriptions, or all prescriptions, written by the EP are queried for a 
drug formulary and transmitted electronically using CEHRT.

Enhanced Feature
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
Denominator

Prescriptions are included in the denominator if they satisfy the following criteria:

Numerator

Prescriptions that satisfy the denominator are included in the numerator if they satisfy all of the following 
criteria:

Note: Based on additional clarification from CMS, Rx eligibility must be verified prior to e-prescribing 
(including responding to refill requests) to get credit for this measure.
This change is effective for the May 1, 2015 reporting period; past data will not be affected. 
Per this clarification, eligibility checks performed on past prescriptions cannot be reused since the 
formulary could have changed. A new eligibility check must be performed each time (or within three 
days before the prescription date) to retrieve the latest formulary information prior to e-prescribing or 
responding to refill requests.
Failure to follow the recommended workflow to perform eligibility checks for each prescription and refill 
request will result in a drop in numerator numbers for this measure.
If provider performance rates have dropped for this measure, it could be the result of one of the 
following reasons:
 Recommended workflow to perform eligibility checks prior to each e-prescription or response to 

refill requests is not being followed.
 Eligibility checks have not been performed for prescriptions and refill requests in the reporting 

period.

Denominator Criteria Area to Document within eClinicalWorks

They have been printed, faxed, or 
transmitted electronically

Record this information from the following locations:
 Progress Notes > Treatment
 Telephone/Web Encounter > Rx Tab
 Telephone/Web Encounter > Virtual Visit tab > Treatment

IMPORTANT! The following medications are excluded from being 
included in the denominator: 
 Duplicate medications (re-printed, re-faxed, re-transmitted, or 

printed and also transmitted) 
 Non-permissible (controlled) medications
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
Exclusions

Providers may be excluded from this measure if they meet the following criteria: 

Numerator Criteria Area to Document within eClinicalWorks

They have been queried for 
a drug formulary from the 
Rx Eligibility window.

Record this information from the following locations:
 Progress Notes > Treatment > green arrow next to Send Rx > ePrescribe 

Rx > Rx Eligibility
 Appointment window > Rx Eligibility > Check Rx Eligibility
 Progress Notes > Treatment > Add > Rx Eligibility > Check Rx Eligibility:
 Telephone/Web Encounter > Rx tab > Rx Eligibility > Check Rx Eligibility
 Telephone/Web Encounter > Telephone/Web Encounter > Rx tab > 

green arrow next to Send Rx > ePrescribe Rx > Rx Eligibility
 eRefill > Rx Eligibility > Check Rx Eligibility

IMPORTANT! Rx eligibility must be verified for all patients, including self-pay 
patients, every time a prescription is sent.
Whenever an Rx Eligibility check is performed in eClinicalWorks, the check 
lasts for three (3) days. Prescriptions and refill requests created within the 
three days after an eligibility check has been performed are considered 
verified.
Any prescription or refill request created after these three days requires that 
a new eligibility check be performed in order to satisfy this measure.

Note: A Scheduled Job can also be run every night (for scheduled 
appointments only). You must verify Rx Eligibility manually before e-
Prescribing for walk-in appointments, Telephone/Web Encounter orders, and 
eRefill requests

They have been transmitted 
using e-Prescription from 
the ePrescribe Rx window

Record this information from the following locations:
 E quick-launch link > Refill Rx or Error/Failed Rx
 Progress Notes > Treatment > green arrow next to Send Rx > ePrescribe 

Rx
 Telephone/Web Encounter > Rx tab > green arrow next to Send Rx > 

ePrescribe Rx
 Telephone/Web Encounter > Virtual Visit > Treatment> green arrow 

next to Send Rx > ePrescribe Rx
 Progress Notes > Send
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
Features Related to Core 2

The following features are related to satisfying Core Measure 2:

 Transmitting Prescriptions

 Checking Rx Eligibility

 e-Prescribing Medications

Exclusion Criteria Area to Document within eClinicalWorks

They write fewer than 100 
permissible prescriptions during the 
EHR reporting period.

This exclusion criteria is reported by self-attestation.

They do not have a pharmacy 
within their organization and there 
are no pharmacies that accept 
electronic prescriptions within 10 
miles of the EP's practice location 
at the start of his/her EHR 
reporting period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
Transmitting Prescriptions

 Progress Notes > Treatment
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
 Telephone/Web Encounter > Rx Tab

 Telephone/Web Encounter > Virtual Visit tab > Treatment
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 37



CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
Checking Rx Eligibility

 Progress Notes > Treatment > green arrow next to Send Rx > ePrescribe Rx > Rx Eligibility

 Appointment window > Rx Eligibility > Check Rx Eligibility

 Progress Notes > Treatment > Add > Rx Eligibility > Check Rx Eligibility: 
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
 Telephone/Web Encounter > Rx tab > Rx Eligibility > Check Rx Eligibility

 Telephone/Web Encounter > Telephone/Web Encounter > Rx tab > green arrow next to Send Rx > 
ePrescribe Rx > Rx Eligibility

 eRefill > Rx Eligibility > Check Rx Eligibility
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
e-Prescribing Medications

 E quick-launch link > Refill Rx or Error/Failed Rx

 Progress Notes > Treatment > green arrow next to Send Rx > ePrescribe Rx
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
 Telephone/Web Encounter > Rx tab > green arrow next to Send Rx > ePrescribe Rx
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CORE MEASURES CORE 2: GENERATING AND TRANSMITTING E-PRESCRIPTIONS
 Telephone/Web Encounter > Virtual Visit > Treatment> green arrow next to Send Rx > ePrescribe Rx

 Progress Notes > Send
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CORE MEASURES CORE 3: RECORDING DEMOGRAPHICS
Core 3: Recording Demographics
Objective

Record the following demographics: preferred language, sex, race, ethnicity, and date of birth.

Measure

More than 80 percent of all unique patients seen by the EP have demographics recorded as structured data.

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if all of the following information is 
recorded for them:

Features Related to Core 3

The following features are related to satisfying Core Measure 3:

 Recording Appointments

 Recording E&M Codes

 Mapping Community Languages

 Recording Demographic Information

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Numerator Criteria Area to Document within eClinicalWorks

They have had their date of birth, 
gender (sex), language, race, and 
ethnicity entered in patient 
demographics.

Record this information from the following locations:
 Community > Mappings > Language
 Patient Information > Date of Birth and Sex
 Patient Information > Additional Info > Race, Ethnicity, and 

Language

Note:  Preferred languages must be recorded in accordance with ISO 
639-2 alpha-3 codes standards.
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CORE MEASURES CORE 3: RECORDING DEMOGRAPHICS
Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 3: RECORDING DEMOGRAPHICS
Mapping Community Languages

This is a one-time setup that must be performed for each language used:

 Community > Mappings > Language

Recording Demographic Information

 Patient Information > Date of Birth and Sex
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
 Patient Information > Additional Info > Race, Ethnicity, and Language

Core 4: Recording Vital Signs
Objective

Record and chart changes in the following vital signs: height/length and weight (no age limit); blood pressure 
(ages 3 and over); calculate and display body mass index (BMI); and plot and display growth charts for patients 
0-20 years, including BMI.

Measure

More than 80 percent of all unique patients seen by the EP have blood pressure (for patients aged three years 
and over only) and/or height and weight (for all ages) recorded as structured data.
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Core 4-1

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy the following criteria:

Exclusions

Providers may be excluded from this measure if they meet the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Numerator Criteria Area to Document within eClinicalWorks

They have had their height, weight, 
and blood pressure recorded 
(blood pressure is only applicable 
to patients three years of age and 
older)

Record this information from the following locations:
 EMR > Vitals > Configure Vitals
 Progress Notes > Vitals

Note:  The required vitals do not all have to be recorded in the same 
encounter, nor do they have to be recorded during the reporting 
period.  They can be recorded over multiple encounters at any time, 
as long as all three are recorded during office visits.

IMPORTANT!  These Vitals categories must be associated with the 
corresponding Vital Types (from EMR > Vitals > Configure Vitals) for 
patients to be counted in the numerator.

Exclusion Criteria Area to Document within eClinicalWorks

They believe all three vital signs 
(height, weight, and blood 
pressure) are not relevant to the 
scope of their practice

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Features Related to Core 4-1

The following features are related to Core Measure 4-1:

 Recording Appointments

 Recording E&M Codes

 Configuring Vitals

 Recording Height, Weight, and Blood Pressure

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Configuring Vitals

Each vital must be linked to the appropriate standard vital type once to satisfy this measure:

 EMR > Vitals > Configure Vitals

Recording Height, Weight, and Blood Pressure

 Progress Notes > Vitals
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Core 4-2

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Numerator Criteria Area to Document within eClinicalWorks

They have had their height and 
weight recorded 

Record this information from the following locations:
 EMR > Vitals > Configure Vitals
 Progress Notes > Vitals

Note:  The required vitals do not all have to be recorded in the same 
encounter, nor do they have to be recorded during the reporting 
period.  They can be recorded over multiple encounters at any time, 
as long as all three are recorded during office visits.

IMPORTANT!  These Vitals categories must be associated with the 
corresponding Vital Types (from EMR > Vitals > Configure Vitals) for 
patients to be counted in the numerator.
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Exclusions

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Core 4-2

The following features are related to Core Measure 4-2:

 Recording Appointments

 Recording E&M Codes

 Configuring Vitals

 Recording Height and Weight

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

Exclusion Criteria Area to Document within eClinicalWorks

They believe that blood pressure is 
relevant to their scope of practice, 
but height/length and weight are 
not, they are excluded from 
recording height/length and weight

This exclusion criteria is reported by self-attestation.

They believe all three vital signs 
(height, weight, and blood 
pressure) are not relevant to the 
scope of their practice, they are 
excluded from this measure 
entirely

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M

Configuring Vitals

Each vital must be linked to the appropriate standard vital type once to satisfy this measure:

 EMR > Vitals > Configure Vitals
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Recording Height and Weight

 Progress Notes > Vitals

Core 4-3

Denominator

Patients are included in the denominator if they satisfy ALL of the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They are three years of age or older 
during the reporting period

Patient Information

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Numerator Criteria Area to Document within eClinicalWorks

They have had their blood pressure 
recorded 

Record this information from the following locations:
 EMR > Vitals > Configure Vitals
 Progress Notes > Vitals

Note:  This vital does not have to be recorded during the reporting 
period.

IMPORTANT!  These Vitals categories must be associated with the 
corresponding Vital Types (from EMR > Vitals > Configure Vitals) for 
patients to be counted in the numerator.
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Exclusions

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Core 4-3

The following features are related to Core Measure 4-3:

 Recording Date of Birth

 Recording Appointments

 Recording E&M Codes

 Configuring Vitals

 Recording Blood Pressure

Recording Date of Birth

 Patient Information

Exclusion Criteria Area to Document within eClinicalWorks

They see no patients three (3) 
years of age or older, they are 
excluded from recording blood 
pressure

This exclusion criteria is reported by self-attestation.

They believe that height/length and 
weight are relevant to the scope of 
their practice, but blood pressure is 
not, they are excluded from 
recording blood pressure

This exclusion criteria is reported by self-attestation.

They believe all three vital signs 
(height, weight, and blood 
pressure) are not relevant to the 
scope of their practice, they are 
excluded from this measure 
entirely

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 4: RECORDING VITAL SIGNS
Configuring Vitals

Each vital must be linked to the appropriate standard vital type once to satisfy this measure:

 EMR > Vitals > Configure Vitals

Recording Blood Pressure

 Progress Notes > Vitals
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CORE MEASURES CORE 5: RECORDING SMOKING STATUS
Core 5: Recording Smoking Status
Objective

Record smoking status for patients 13 years old or older.

Measure

More than 80 percent of all unique patients 13 years old or older seen by the EP have smoking status recorded 
as structured data.

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR

 Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 5: RECORDING SMOKING STATUS
Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy the following criteria:

Exclusion

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Core 5

The following features are related to Core Measure 5:

 Recording Appointments

 Recording E&M Codes

Numerator Criteria Area to Document within eClinicalWorks

They have had their smoking status 
recorded as structured data.

Configure options related to this measure from the following 
locations:
 Community > Mappings > Structured Data

OR
Community > Mappings > Smart Forms

Record this information from the following locations:
 Progress Notes > Social History

OR
Progress Notes > SF drop-down list > Tobacco Control

IMPORTANT!  The following options satisfy this measure:
 Current smoker
 Heavy tobacco smoker
 Light tobacco smoker
 Former smoker
 Never smoker
 Current every day smoker
 Current some day smoker
 Smoker, current status unknown
Unknown if ever smoked

Note:  The Tobacco Use Smart Form can also be used to satisfy this 
measure.

Exclusion Criteria Area to Document within eClinicalWorks

They performed no encounters for 
patients over the age of 13 during 
the reporting period.

This exclusion criteria is reported by self-attestation.
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 58



CORE MEASURES CORE 5: RECORDING SMOKING STATUS
 Mapping Community Structured Data

 Mapping Smart Forms

 Recording Smoking Status

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 5: RECORDING SMOKING STATUS
Mapping Community Structured Data

 Community > Mappings > Structured Data

Mapping Smart Forms

 Community > Mappings > Smart Forms
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CORE MEASURES CORE 5: RECORDING SMOKING STATUS
Recording Smoking Status

 Progress Notes > Social History

 Progress Notes > SF drop-down list > Tobacco Control
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CORE MEASURES CORE 6: CLINICAL DECISION SUPPORT RULE
Core 6: Clinical Decision Support Rule
Objective

Use clinical decision support to improve performance on high-priority health conditions.

Measure 1

Implement five clinical decision support interventions related to four or more clinical quality measures at a 
relevant point in patient care for the entire EHR reporting period. Absent four clinical quality measures related 
to an EP’s scope of practice or patient population, the clinical decision support interventions must be related to 
high-priority health conditions. 

Measure 2

The EP has enabled and implemented the functionality for drug-drug and drug-allergy interaction checks for the 
entire EHR reporting period. 

Core 6 Measure 1

The following features are available to assist in decision-making:

Features Related to Core 6 Measure 1

The following features are related to Core 6 Measure 1:

 Configuring Classic Alerts

 Configuring Registry Alerts

 Configuring CDSS Alerts

IMPORTANT! No denominator/numerator calculations are required for this measure.  This measure is 
reported through self-attestation.

Feature Area to Document within eClinicalWorks

Classic Alerts EMR > Alerts

Registry Alerts Registry band > Registry icon > run a query > Save Queries

CDSS Alerts EMR > CDSS > Measure Configuration

Note: For more information on using these features, refer to the Electronic Medical Records Users Guide 
or the HelpHub.
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CORE MEASURES CORE 6: CLINICAL DECISION SUPPORT RULE
Configuring Classic Alerts

This is a one-time setup process, with periodic maintenance as needed:

 EMR > Alerts
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CORE MEASURES CORE 6: CLINICAL DECISION SUPPORT RULE
Configuring Registry Alerts

 Registry band > Registry icon > run a query > Save Queries

Configuring CDSS Alerts

This is a one-time setup process, with yearly maintenance:

 EMR > CDSS > Measure Configuration
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CORE MEASURES CORE 6: CLINICAL DECISION SUPPORT RULE
Core 6 Measure 2

The following features are available to assist in decision-making:

Features Related to Core 6 Measure 2

The following features are related to Core 6 Measure 1:

 Using Drug Interaction Checking

Using Drug Interaction Checking

 Progress Notes > Current Medication > Drug Interaction

Feature Area to Document within eClinicalWorks

Drug Interaction Checks Access this feature from one of the following locations:
 Progress Notes > Current Medication > Drug Interaction
 Progress Notes > Treatment > Interaction

Note: For more information on using these features, refer to the Electronic Medical Records Users Guide 
or the HelpHub.
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CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
 Progress Notes > Treatment > Interaction

Core 7: Patient Electronic Access
Objective

Provide patients the ability to view online, download, and transmit their health information within four 
business days of the information being available to the EP.

Core 7-1

Measure

More than 50 percent of all unique patients seen by the EP during the EHR reporting period are provided timely 
(available to the patient within four (4) business days after the information is available to the EP) online access 
to their health information. 
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CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
Denominator

Patients are included in the denominator if they satisfy the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy ONE of the following criteria:

Exclusion

Providers may be excluded from this measure if they meet the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Numerator Criteria Area to Document within eClinicalWorks

They have been web-enabled any 
time before, during, or within four 
(4) business days of the 
appointment.

Record this information from one of the following locations:
 Patient Information > Options > Web Enable
 Appointment window > W check box

The patient is unwilling to disclose 
their e-mail address.

Patient Information > Additional Info > Email drop-down list and Not 
Provided check box

Exclusion Criteria Area to Document within eClinicalWorks

They neither order nor create any 
of the information listed for 
inclusion as part of this measure, 
except for Patient name and 
Provider's name and office contact 
information, may be excluded from 
this measure.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
Features Related to Core 7-1

The following features are related to Core Measure 7-1:

 Recording Appointments

 Recording E&M Codes

 Web-Enabling Patients

 Recording Patients’ e-Mail Addresses

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
Web-Enabling Patients

 Patient Information > Options > Web Enable

 Appointment window > W check box
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 69



CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
Recording Patients’ e-Mail Addresses

 Patient Information > Additional Info > Email drop-down list and Not Provided check box

Core 7-2

Measure

More than five (5) percent of all unique patients seen by the EP during the EHR reporting period (or their 
authorized representatives) view, download, or transmit their health information to a third party.

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy the following criteria:

Exclusions

Providers may be excluded from this measure under the following circumstances:

Numerator Criteria Area to Document within eClinicalWorks

They have viewed their health 
information by logging into the 
Patient Portal

Web browser > URL > enter information in Username and Password 
fields > Sign In

They have downloaded their PHR 
or Visit Summary from the Patient 
Portal

Patient Portal > left navigation menu or Request PHR button

They have transmitted their health 
information to a third party from 
one of the links in the Medical 
Records section of the left 
navigation pane on the Patient 
Portal

Patient Portal > Medical Record > Personal Health Share > Share

IMPORTANT!  Transmitting health information to a third party 
requires the patient to enter the direct address of the provider.  
Providers can request direct address after enrolling in JTN (Join the 
Network) from the following web address: https://
my.eclinicalworks.com/eCRM/jsp/
productJoinTheNetwork.jsp?pgId=7&prodId=3. For more information, 
refer to Requesting a Direct Address.

Note: For more information on the options available to patients from the Patient Portal, refer to the 
Patient Portal Users Guide or the HelpHub.

Exclusion Criteria Area to Document within eClinicalWorks

They neither order nor create any of 
the information listed for inclusion 
as part of this measure, except for 
Patient name and Provider's name 
and office contact information.

This exclusion criteria is reported by self-attestation.

They conduct 50 percent or more 
of their patient encounters in a 
county that does not have 50 
percent or more of its housing units 
with 3Mbps broadband availability, 
according to the latest information 
available from the FCC on the first 
day of the EHR reporting period.

This exclusion criteria is reported by self-attestation.
Information on broadband availability can be found at: http://
www.broadbandmap.gov/
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CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
Features Related to Core 7-2

The following features are related to Core Measure 7-2:

 Recording Appointments

 Recording E&M Codes

 Logging Into the Patient Portal

 Downloading PHRs or Visit Summaries

 Transmitting Health Information

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 7: PATIENT ELECTRONIC ACCESS
Logging Into the Patient Portal

 Web browser > URL > enter information in Username and Password fields > Sign In

Downloading PHRs or Visit Summaries

 Patient Portal > left navigation menu or Request PHR button
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CORE MEASURES CORE 8: PROVIDING CLINICAL SUMMARIES
Transmitting Health Information

 Patient Portal > Medical Record > Personal Health Share > Share

Core 8: Providing Clinical Summaries
Objective

Provide clinical summaries for patients for each office visit.

Measure

Clinical summaries provided to patients or patient-authorized representatives within one business day for more 
than 50 percent of office visits. 
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CORE MEASURES CORE 8: PROVIDING CLINICAL SUMMARIES
Denominator

Patients are included in the denominator if they satisfy the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if they meet ONE of the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Numerator Criteria Area to Document within eClinicalWorks

They have a printed visit summary 
within one (1) business day 
(excluding federal, but not state, 
holidays) of their encounter.

Record this information from the following locations:
 Progress Notes > arrow next to the Print button > Print Visit 

Summary > Print Options > Print Preview or Decline
 Practice band > Resource/Provider Scheduling icon > right-click 

on appointment > Print Visit Summary > Print Preview or Decline
 Progress Notes > Send

IMPORTANT!  Printing the Progress Notes does NOT satisfy this 
measure. The Visit Summary must be printed to receive credit.

They have been web-enabled 
before, during, or within one (1) 
business day (excluding federal, but 
not state, holidays) of their 
encounter

Record this information from the following locations:
 Admin > Patient Portal Settings > Feature Settings
 Patient Information > Options > Web Enable
 Appointment window > W check box
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CORE MEASURES CORE 8: PROVIDING CLINICAL SUMMARIES
Exclusion

Providers are excluded from satisfying this measure if they meet the following criteria:

Features Related to Core 8

The following features are related to Core Measure 8:

 Recording Appointments

 Recording E&M Codes

 Printing a Visit Summary

 Enabling Visit Summaries on the Patient Portal

 Web Enabling Patients

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

Exclusion Criteria Area to Document within eClinicalWorks

They have no appointments 
recorded during the reporting 
period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 8: PROVIDING CLINICAL SUMMARIES
 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M

Printing a Visit Summary

 Progress Notes > arrow next to the Print button > Print Visit Summary > Print Options > Print Preview or 
Decline
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 77



CORE MEASURES CORE 8: PROVIDING CLINICAL SUMMARIES
 Practice band > Resource/Provider Scheduling icon > right-click on appointment > Print Visit Summary > 
Print Preview or Decline

 Progress Notes > Send
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CORE MEASURES CORE 8: PROVIDING CLINICAL SUMMARIES
Enabling Visit Summaries on the Patient Portal

This is a one-time setup procedure:

 Admin > Patient Portal Settings > Feature Settings
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CORE MEASURES CORE 8: PROVIDING CLINICAL SUMMARIES
Web Enabling Patients

 Patient Information > Options > Web Enable

 Appointment window > W check box
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CORE MEASURES CORE 9: PROTECT ELECTRONIC HEALTH INFORMATION
Core 9: Protect Electronic Health Information
Objective

Protect electronic health information created or maintained by the Certified EHR Technology through the 
implementation of appropriate technical capabilities.

Measure

Conduct or review a security risk analysis in accordance with the requirements under 45 CFR 164.308(a ) (1), 
including addressing the encryption/security of data stored in CEHRT in accordance with requirements under 45 
CFR 164.312 (a)(2)(iv) and 45 CFR 164.306(d)(3), and implement security updates as necessary and correct 
identified security deficiencies as part of the provider's risk management process for EPs. 

The following features are available to assist in protecting electronic health information:

IMPORTANT!  No denominator/numerator calculations are required for this measure.  This measure is 
reported through self-attestation.

Note:  Regardless of whether a practice is locally hosted or hosted in the cloud, a Security Risk 
Assessment must be conducted by each practice at least once every year.

Feature Area to Document within eClinicalWorks

Security Attributes File > Security Settings

Rx Security File > Security Settings > Rx Security

P.S.A.C. Access this feature from one of the following locations:
 File > P.S.A.C. Settings > New
 File > P.S.A.C. Settings > select group name > assign members > 

Save
 File > P.S.A.C. Settings > select group name > Advanced Settings

Confidential Progress Notes Progress Notes > Visit Code > Confidential Note

Confidential Patient Accounts Patient Information > P.S.A.C.

Authentication Settings File > Settings > Authentication Settings

Admin Logs Admin band > Admin Logs icon

Note:  For more information on how to use these features, refer to the System Administration Users 
Guide or the HelpHub.
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CORE MEASURES CORE 9: PROTECT ELECTRONIC HEALTH INFORMATION
Features Relating to Core 9

The following features are related to Core Measure 9:

 Using Security Settings

 Using Rx Security

 Using P.S.A.C.

 Making Progress Notes Confidential

 Making Patient Accounts Confidential

 Setting Up Authentication Settings

 Reviewing Administrative Logs

Using Security Settings

 File > Security Settings
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CORE MEASURES CORE 9: PROTECT ELECTRONIC HEALTH INFORMATION
Using Rx Security

 File > Security Settings > Rx Security
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CORE MEASURES CORE 9: PROTECT ELECTRONIC HEALTH INFORMATION
Using P.S.A.C.

 File > P.S.A.C. Settings > New

 File > P.S.A.C. Settings > select group name > assign members > Save
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CORE MEASURES CORE 9: PROTECT ELECTRONIC HEALTH INFORMATION
 File > P.S.A.C. Settings > select group name > Advanced Settings

Making Progress Notes Confidential

 Progress Notes > Visit Code > Confidential Note
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CORE MEASURES CORE 9: PROTECT ELECTRONIC HEALTH INFORMATION
Making Patient Accounts Confidential

 Patient Information > P.S.A.C.
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CORE MEASURES CORE 9: PROTECT ELECTRONIC HEALTH INFORMATION
Setting Up Authentication Settings

 File > Settings > Authentication Settings
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
Reviewing Administrative Logs

 Admin band > Admin Logs icon

Core 10: Incorporating Lab Test Results as Structured 
Data

Objective

Incorporate clinical lab test results into Certified EHR Technology as structured data.

Measure

More than 55 percent of all clinical lab tests results ordered by the EP during the EHR reporting period whose 
results are either in a positive/negative or numerical format are incorporated in Certified EHR Technology as 
structured data.
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
Denominator

Clinical labs are included in the denominator if they satisfy the following criteria:

Numerator

Clinical labs in the denominator are included in the numerator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have been ordered and had 
results recorded during the 
reporting period

Record this information from the following locations:
 L jellybean > New > Lab > Sel
 Progress Notes > Treatment > Browse button in the Labs section 

> Lookup
 Progress Notes > Lab Reports > Lookup
 Patient Hub > Labs > New > Sel
 Telephone/Web Encounter > Labs/DI tab > select Labs from 

drop-down list > New > Sel
 Telephone/Web Encounter > Virtual Visit tab > Treatment > 

Browse button in the Labs section > Lookup
 Telephone/Web Encounter > Virtual Visit tab > Lab Reports > 

Lookup

IMPORTANT!  A lab is only considered to be ordered for your patient 
if you are listed as the Ordering Provider.

IMPORTANT!  Labs in the Microbiology category are excluded from 
this calculation.  Labs can be associated with categories from:
EMR > Labs, DI & Procedures > Labs > search for and highlight a lab > 
green arrow next to the New button > Update > Associate Category

Numerator Criteria Area to Document within eClinicalWorks

They have results entered and are 
marked as received from the Lab 
Results window.

Record this information from the following locations:
 L jellybean > click on lab
 Progress Notes > Treatment > Lab link
 Progress Notes > Lab Reports > Lab link
 Progress Notes > right Chart Panel > Labs/DI tab > click on lab
 Patient Hub > Labs > click on lab
 Telephone/Web Encounter > Labs/DI tab > click on lab
 Telephone/Wen Encounter > Virtual Visit tab > Treatment > Lab 

link
 Telephone/Wen Encounter > Virtual Visit tab > Lab Reports > Lab 

link
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
Exclusion

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Core 10

The following features are related to Core Measure 10:

 Ordering Labs

 Associating Categories with Labs

 Recording Lab Results and Marking Labs as Received

Ordering Labs

 L jellybean > New > Lab > Sel

Exclusion Criteria Area to Document within eClinicalWorks

They have not ordered any tests 
with results that are either in a 
positive/negative or numeric 
format during the reporting period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
 Progress Notes > Treatment > Browse button in the Labs section > Lookup

 Progress Notes > Lab Reports > Lookup

 Patient Hub > Labs > New > Sel
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
 Telephone/Web Encounter > Labs/DI tab > select Labs from drop-down list > New > Sel
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
 Telephone/Web Encounter > Virtual Visit tab > Treatment > Browse button in the Labs section > Lookup
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
 Telephone/Web Encounter > Virtual Visit tab > Lab Reports > Lookup

Associating Categories with Labs

 EMR > Labs, DI & Procedures > Labs > search for and highlight a lab > green arrow next to the New button 
> Update > Associate Category
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
Recording Lab Results and Marking Labs as Received

 L jellybean > click on lab

 Progress Notes > Treatment > Lab link

 Progress Notes > Lab Reports > Lab link

 Progress Notes > right Chart Panel > Labs/DI tab > click on lab
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CORE MEASURES CORE 10: INCORPORATING LAB TEST RESULTS AS STRUCTURED DATA
 Patient Hub > Labs > click on lab

 Telephone/Web Encounter > Labs/DI tab > click on lab
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CORE MEASURES CORE 11: PATIENT LISTS
 Telephone/Wen Encounter > Virtual Visit tab > Treatment > Lab link

 Telephone/Wen Encounter > Virtual Visit tab > Lab Reports > Lab link

Core 11: Patient Lists
Objective

Generate lists of patients by specific conditions to use for quality improvement, reduction of disparities, 
research, or outreach.

Measure

Generate at least one report listing patients of the EP with a specific condition.

The following features are available to assist in generating lists:

Features Related to Core 11

The following features are related to Core 11:

 Using the Registry

IMPORTANT!  No denominator/numerator calculations are required for this measure.  This measure is 
reported through self-attestation.

Feature Area to Document within eClinicalWorks

Registry Access this information from the following locations:
 Registry band > Registry icon > run a query > Save Queries
 Registry band > Registry icon > Analyze Data > Copy

Note:  For more information on how to use these features, refer to the Electronic Medical Records Users 
Guide or the HelpHub.
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CORE MEASURES CORE 11: PATIENT LISTS
Using the Registry

 Registry band > Registry icon > run a query > Save Queries

 Registry band > Registry icon > Analyze Data > Copy
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CORE MEASURES CORE 12: PREVENTIVE CARE
Core 12: Preventive Care
Objective

Use clinically relevant information to identify patients who should receive reminders for preventive/follow-up 
care and send these patients the reminders, per patient preference.

Measure

More than 10 percent of all unique patients who have had 2 or more office visits with the EP within the 24 
months before the beginning of the EHR reporting period were sent a reminder, per patient preference when 
available. 

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had at least two (2) 
outpatient appointment with a 
valid CPT* code created for them 
with an eligible professional within 
24 months before the start of the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 12: PREVENTIVE CARE
Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy at least ONE of the following 
criteria:

Numerator Criteria Area to Document within eClinicalWorks

They are sent a follow-up, health 
maintenance, or preventive care 
letter reminder.

Record this information from the following locations:
 Patient Hub > Messenger > Messenger Configuration
 Patient Information > Speaker icon
 Registry band > Patient Recall icon > generate/select a list of 

patients > click More (...) next to the letter field > select a 
template > Run Letter > Print

 Registry band > Lookup Encounter icon > generate/select a list of 
patients > click More (...) next to the letter field > select a 
template > Run Letter > Print

 Registry band > Registry icon > generate/select a list of patients > 
click More (...) next to the letter field > select a template > Run 
Letter > Print

 Patient Hub > Letters > generate/select a list of patients > click 
More (...) next to the letter field > select a letter > Run Letter > 
Print

IMPORTANT!  Only letters using templates that have been configured 
as Follow-Up, Health Maintenance, or Preventive Care satisfy this 
measure.  Letter template categories are configure from the following 
location:
Registry band > Registry icon > click More (...) next to the letter field > 
select a letter > New or Update > Category

They are sent a health maintenance 
voice or text message.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > Bump Appointment 

icon > Messenger
 Patient Hub > Messenger > Send Message
 Registry band > Patient Recall icon > Messenger
 Registry band > Lookup Encounters icon > Messenger
 Registry bad > Registry icon > Messenger
 Practice band > Office Visits icon > Messenger
 S jellybean > Messenger
 Practice band > Resource Scheduling icon > right-click on an 

appointment > Messenger
 Practice band > Telephone/Web Encounter icon > Messenger
 T jellybean > Messenger
 Practice Band > Labs/Imaging icon > Messenger
 L jellybean > Messenger
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CORE MEASURES CORE 12: PREVENTIVE CARE
Exclusion

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Core 12

The following features are related to Core Measure 12:

 Recording Appointments

 Recording E&M Codes

 Recording Patients’ Message Preferences

 Sending Letter Reminders

 Configuring Letter Categories

 Sending Voice or Text Message Reminders

 Sending eMessages

 Configuring Alert Reminders on the Patient Portal

IMPORTANT!  Messages must be Health Maintenance message types 
to satisfy this measure. 

IMPORTANT!  eClinicalWorks Messenger must be enabled and 
configured to use this feature. For more information, refer to the 
eClinicalWorks Messenger Users Guide.

They are sent a preventive or 
follow-up care e-message.

Record this information from the following locations:
 Patient Hub > Send eMsg
 Registry band > Patient Recall icon > eMsg
 Registry band > Lookup Encounters icon > Send eMsg
 Registry band > Lookup Encounters icon > Blast eMsgs
 Registry band > Registry icon > Send eMessage

They are sent an alert reminder 
enabled for the Patient Portal.

Admin band > Patient Portal Settings icon > Feature Settings

Exclusion Criteria Area to Document within eClinicalWorks

They have had no office visits in the 
24 months before the EHR 
reporting period.

This exclusion criteria is reported by self-attestation.

Numerator Criteria Area to Document within eClinicalWorks
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CORE MEASURES CORE 12: PREVENTIVE CARE
Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 12: PREVENTIVE CARE
Recording Patients’ Message Preferences

 Patient Hub > Messenger > Messenger Configuration

 Patient Information > Speaker icon
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CORE MEASURES CORE 12: PREVENTIVE CARE
Sending Letter Reminders

 Registry band > Patient Recall icon > generate/select a list of patients > click More (...) next to the letter 
field > select a template > Run Letter > Print
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Registry band > Lookup Encounter icon > generate/select a list of patients > click More (...) next to the 
letter field > select a template > Run Letter > Print
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Registry band > Registry icon > generate/select a list of patients > click More (...) next to the letter field > 
select a template > Run Letter > Print
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Patient Hub > Letters > generate/select a list of patients > click More (...) next to the letter field > select a 
letter > Run Letter > Print

Configuring Letter Categories

 Registry band > Registry icon > click More (...) next to the letter field > select a letter > New or Update > 
Category
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CORE MEASURES CORE 12: PREVENTIVE CARE
Sending Voice or Text Message Reminders

 Practice band > Resource Scheduling icon > Bump Appointment icon > Messenger
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Patient Hub > Messenger > Send Message

 Registry band > Patient Recall icon > Messenger
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Registry band > Lookup Encounters icon > Messenger

 Registry bad > Registry icon > Messenger
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 110



CORE MEASURES CORE 12: PREVENTIVE CARE
 Practice band > Office Visits icon > Messenger
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CORE MEASURES CORE 12: PREVENTIVE CARE
 S jellybean > Messenger

 Practice band > Resource Scheduling icon > right-click on an appointment > Messenger
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Practice band > Telephone/Web Encounter icon > Messenger

 T jellybean > Messenger
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Practice Band > Labs/Imaging icon > Messenger

 L jellybean > Messenger
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CORE MEASURES CORE 12: PREVENTIVE CARE
Sending eMessages

 Patient Hub > Send eMsg
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Registry band > Patient Recall icon > eMsg
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Registry band > Lookup Encounters icon > Send eMsg
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CORE MEASURES CORE 12: PREVENTIVE CARE
 Registry band > Lookup Encounters icon > Blast eMsgs

 Registry band > Registry icon > Send eMessage
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CORE MEASURES CORE 13: PATIENT-SPECIFIC EDUCATION RESOURCES
Configuring Alert Reminders on the Patient Portal

 Admin band > Patient Portal Settings icon > Feature Settings

Core 13: Patient-Specific Education Resources

Objective

Use clinically relevant information from Certified EHR Technology to identify patient-specific education 
resources and provide those resources to the patient.

Measure

Patient-specific education resources identified by Certified EHR Technology are provided to patients for more 
than 10 percent of all unique patients with office visits seen by the EP during the EHR reporting period. 

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Enhanced Feature

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 13: PATIENT-SPECIFIC EDUCATION RESOURCES
Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy at least ONE of the following 
criteria:

Features Related to Core 13

The following features are related to Core Measure 13:

 Recording Appointments

 Recording E&M Codes

 Printing and Ordering Education

*. CPT copyright 2014 American Medical Association. All rights reserved.

Numerator Criteria Area to Document within eClinicalWorks

They have had at least one (1) 
piece of education printed or 
published

Record this information from the following locations:
 Progress Notes > Treatment > Education > Rx Education > 

Medications (English) or Medications (Spanish) > View Rx 
Education > Print

 Progress Notes > Treatment > Education > Patient Education > 
Print*

 Progress Notes > Treatment > Education > Patient Education > 
Publish to Portal check box*

 Progress Notes > Treatment > OS icon > Patient Education > PDF 
or Web Reference > Order

 Progress Notes > Send > For Patients

*. Users must be signed up with one of the education partners to have access to Patient Education * feature. 
For EPs attesting after Q2 2014, all of eClinicalWorks’ education vendors (which includes Healthwise, ADAM, 
and Krames) are 2014-certified.

IMPORTANT! Custom education given through Progress Notes > 
Treatment > Education > Custom Education does not count toward 
the numerator because it does not use patients’ clinical information 
stored in the CEHRT to identify that resource.

Note: In May 2015, per CMS FAQ 8231, this measure was modified to 
consider education material given in the year 2015 to receive credit 
for the numerator. Any material given prior to 2015 was not 
considered in the numerator calculations.
CMS has revoked this FAQ until further notice, and as per CMS, the 
measure calculations must be reverted to the specifications prior to 
the FAQ 8231 release. 
The change now states that education material given any time prior 
to the attestation date satisfies this numerator. This change will be 
released in late July 2015. Please refer to my.eclinicalworks.com for 
updates as they become available.
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CORE MEASURES CORE 13: PATIENT-SPECIFIC EDUCATION RESOURCES
Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M
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CORE MEASURES CORE 13: PATIENT-SPECIFIC EDUCATION RESOURCES
Printing and Ordering Education

 Progress Notes > Treatment > Education > Rx Education > Medications (English) or Medications (Spanish) > 
View Rx Education > Print

 Progress Notes > Treatment > Education > Patient Education > Print
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CORE MEASURES CORE 13: PATIENT-SPECIFIC EDUCATION RESOURCES
 Progress Notes > Treatment > Education > Patient Education > Publish to Portal check box

 Progress Notes > Treatment > OS icon > Patient Education > PDF or Web Reference > Order
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CORE MEASURES CORE 14: MEDICATION RECONCILIATION
 Progress Notes > Send > For Patients

Core 14: Medication Reconciliation
Objective

The EP who receives a patient from another setting of care or provider of care or believes an encounter is 
relevant should perform medication reconciliation.
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CORE MEASURES CORE 14: MEDICATION RECONCILIATION
Measure

The EP who performs medication reconciliation for more than 50 percent of transitions of care in which the 
patient is transitioned into the care of the EP. 

Denominator

Patients are included in the denominator if they satisfy ALL of the following criteria:

Numerator

Patients in the denominator are included in the numerator if they satisfy the following criteria:

Exclusion

Providers may be excluded from this measure if they meet the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an appointment 
created for them with the 
Transition of care box checked 
during the reporting period.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on time 

slot > New Appointment > Transition of Care check box
 Practice band > Resource Scheduling icon > double-click on 

appointment > Transition of Care check box
 Practice band > Provider Schedule icon > right-click on time slot > 

New Appointment > Transition of Care check box
 Practice band > Provider Schedule icon > double-click on 

appointment > Transition of Care check box
 Progress Notes > Chief Complaints > Transition of Care check box

They have a valid Outpatient CPT* 
code recorded for the Transition of 
care appointment.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Progress Notes > Visit Code > Add E&M

Note: Telephone Encounters are not counted as appointments. Patients with only Telephone Encounters 
are not included in the denominator for this measure.  

Numerator Criteria Area to Document within eClinicalWorks

Their medications are reconciled 
and marked as verified.

Progress Notes > Current Medication > Verified check box

Exclusion Criteria Area to Document within eClinicalWorks

They were not the recipient of any 
transitions of care during the 
reporting period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 14: MEDICATION RECONCILIATION
Features Related to Core 14

The following features are related to Core Measure 14:

 Recording a Transition of Care

 Recording E&M Codes

 Recording Medication Reconciliation

Recording a Transition of Care

 Practice band > Resource Scheduling icon > right-click on time slot > New Appointment > Transition of Care 
check box
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 126



CORE MEASURES CORE 14: MEDICATION RECONCILIATION
 Practice band > Resource Scheduling icon > double-click on appointment > Transition of Care check box

 Practice band > Provider Schedule icon > right-click on time slot > New Appointment > Transition of Care 
check box
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CORE MEASURES CORE 14: MEDICATION RECONCILIATION
 Practice band > Provider Schedule icon > double-click on appointment > Transition of Care check box

 Progress Notes > Chief Complaints > Transition of Care check box
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CORE MEASURES CORE 15: SUMMARY OF CARE
Recording E&M Codes

 Progress Notes > Visit Code > Add E&M

Recording Medication Reconciliation

 Progress Notes > Current Medication > Verified check box

Core 15: Summary of Care
Objective

The EP who transitions their patient to another setting of care or provider of care or refers their patient to 
another provider of care should provide a summary care record for each transition of care or referral.

Measure

This objective has multiple measure criteria and requires the provider to meet all thresholds for credit.  For 
more information, refer to Core 15-1, Core 15-2, and Core 15-3.
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CORE MEASURES CORE 15: SUMMARY OF CARE
Core 15-1

Measure

The EP who transitions or refers their patient to another setting of care or provider of care provides a summary 
of care record for more than 50 percent of transitions of care and referrals.

Denominator

Referrals are included in the denominator if they satisfy the following criteria:

Denominator 
Criteria

Area to Document within eClinicalWorks

At least one 
outgoing referral 
has been printed, 
faxed, or 
transmitted 
electronically 
using JTN (Join the 
Network) during 
the reporting 
period.

Record this information from the following locations:
 Progress Notes > Treatment > Outgoing Referral > Send Referral > Print, Print with 

attachment(s), Fax, or Fax with attachment(s)
 Progress Notes > Treatment > Outgoing Referral > green arrow next to the Send 

Referral button > Send Electronically
 Progress Notes > green arrow next to Fax button > Fax Consult Notes
 T quick-launch link > Send eCW P2P Patient Record
 T quick-launch link > Send eCW P2P Referral/Consult
 Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing Referral > Send 

Referral > Print, Print with attachment(s), Fax, Fax with attachment(s), or green 
arrow next to the Send Referral button and Send Electronically

 Patient Hub > Referrals > Outgoing > New > Send Referral > Print, Print with 
attachment(s), Fax, Fax with attachment(s), or green arrow next to the Send 
Referral button and Send Electronically

Note: Fax consult notes and/or referrals sent from within the same database can be 
excluded from this denominator using settings on the MAQ Dashboard:

IMPORTANT!  Referrals are only counted for a provider if they are listed as the Referral 
From provider on the referral.
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CORE MEASURES CORE 15: SUMMARY OF CARE
Numerator

Referrals that satisfy the denominator are included in the numerator if they satisfy the following criteria: 

Exclusions

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Core 15-1

The following features are related to Core Measure 15-1:

 Sending Referrals

 Sending Referrals with Attachments

Numerator Criteria Area to Document within eClinicalWorks

At least one outgoing referral has 
been printed, faxed, or transmitted 
with attachments during the 
reporting period.

Record this information from the following locations:
 Progress Notes > Treatment > Outgoing Referral > Send Referral 

> Print with attachment(s) or Fax with attachment(s)
 Progress Notes > Treatment > Outgoing Referral > green arrow 

next to the Send Referral button > Send Electronically
 T quick-launch link > Send eCW P2P Patient Record
 T quick-launch link > Send eCW P2P Referral/Consult
 Telephone/Web Encounter > Virtual Visit > Treatment > 

Outgoing Referral > Send Referral > Print with attachment(s), Fax 
with attachment(s), or green arrow next to the Send Referral 
button and Send Electronically

 Patient Hub > Referrals > Outgoing > New > Send Referral > Print 
with attachment(s), Fax with attachment(s), or green arrow next 
to the Send Referral button and Send Electronically

IMPORTANT!  For the electronic transmission of summary of care 
records (Core Measure 15), transactions must be sent to and from a 
Direct Address. For more information, refer to Requesting a Direct 
Address.
Non-eCW providers can go to http://www.jointhenetwork.com to 
request an eClinicalWorks-issued Direct Address.

Exclusion Criteria Area to Document within eClinicalWorks

They transfer patients to another 
setting or refer patients to another 
provider less than 100 times during 
the reporting period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 15: SUMMARY OF CARE
Sending Referrals

 Progress Notes > Treatment > Outgoing Referral > Send Referral > Print, Print with attachment(s), Fax, or 
Fax with attachment(s)

 Progress Notes > Treatment > Outgoing Referral > green arrow next to the Send Referral button > Send 
Electronically
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Progress Notes > green arrow next to Fax button > Fax Consult Notes
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CORE MEASURES CORE 15: SUMMARY OF CARE
 T quick-launch link > Send eCW P2P Patient Record

 T quick-launch link > Send eCW P2P Referral/Consult
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing Referral > Send Referral > Print, Print with 
attachment(s), Fax, Fax with attachment(s), or green arrow next to the Send Referral button and Send 
Electronically
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Patient Hub > Referrals > Outgoing > New > Send Referral > Print, Print with attachment(s), Fax, Fax with 
attachment(s), or green arrow next to the Send Referral button and Send Electronically

Sending Referrals with Attachments

 Progress Notes > Treatment > Outgoing Referral > Send Referral > Print with attachment(s) or Fax with 
attachment(s)
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing Referral > Send Referral > Print with 
attachment(s), Fax with attachment(s), or green arrow next to the Send Referral button and Send 
Electronically
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Patient Hub > Referrals > Outgoing > New > Send Referral > Print with attachment(s), Fax with 
attachment(s), or green arrow next to the Send Referral button and Send Electronically

Core 15-2

Measure

The EP who transitions or refers their patient to another setting of care or provider of care provides a summary 
of care record for more than 10 percent of such transitions and referrals either (a) electronically transmitted 
using CEHRT to a recipient or (b) where the recipient receives the summary of care record via exchange 
facilitated by an organization that is a NwHIN Exchange participant or in a manner that is consistent with the 
governance mechanism ONC establishes for the NwHIN.
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CORE MEASURES CORE 15: SUMMARY OF CARE
Denominator

Referrals are included in the denominator if they satisfy the following criteria:

Denominato
r Criteria

Area to Document within eClinicalWorks

At least one 
outgoing referral 
has been printed, 
faxed, or 
transmitted 
electronically 
using JTN (Join 
the Network) 
during the 
reporting period.

Record this information from the following locations:
 Progress Notes > Treatment > Outgoing Referral > Send Referral > Print, Print with 

attachment(s), Fax, or Fax with attachment(s)
 Progress Notes > Treatment > Outgoing Referral > green arrow next to the Send 

Referral button > Send Electronically
 Progress Notes > green arrow next to Fax button > Fax Consult Notes
 T quick-launch link > Send eCW P2P Patient Record
 T quick-launch link > Send eCW P2P Referral/Consult
 Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing Referral > Send 

Referral > Print, Print with attachment(s), Fax, Fax with attachment(s), or green 
arrow next to the Send Referral button and Send Electronically

 Patient Hub > Referrals > Outgoing > New > Send Referral > Print, Print with 
attachment(s), Fax, Fax with attachment(s), or green arrow next to the Send 
Referral button and Send Electronically

Note: Fax consult notes and/or referrals sent from within the same database can be 
excluded from this denominator using settings on the MAQ Dashboard:

IMPORTANT! Referrals are only counted for a provider if they are listed as the Referral 
From provider on the referral.
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CORE MEASURES CORE 15: SUMMARY OF CARE
Numerator

Referrals that satisfy the denominator are included in the numerator if they satisfy the following criteria: 

Exclusions

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Core 15-2

The following features are related to Core Measure 15-2:

 Sending Referrals

 Sending Referrals with Attachments

Numerator Criteria Area to Document within eClinicalWorks

They were transmitted through the 
P2P Portal with a medical 
summary, CCR/CCD, and Progress 
Notes attached

Record this information from the following locations:
 T quick-launch link > Send eCW P2P Patient Record > 

Attachments > Send
 T quick-launch link > Send eCW P2P Referral/Consult > 

Attachments or green arrow next to the Send Referral button 
and Send Electronically

 Telephone/Web Encounter > Virtual Visit > Treatment > 
Outgoing Referral > Attachments > Send Referral or green arrow 
next to the Send Referral button and Send Electronically

 Patient Hub > Referrals > Outgoing > New > Attachments > Send 
Referral or green arrow next to the Send Referral button and 
Send Electronically

IMPORTANT! For the electronic transmission of summary of care 
records (Core Measure 15), transactions must be sent to and from a 
Direct Address. For more information, refer to Requesting a Direct 
Address.
Non-eCW providers can go to http://www.jointhenetwork.com to 
request an eClinicalWorks-issued Direct Address.

Exclusion Criteria Area to Document within eClinicalWorks

They transfer patients to another 
setting or refer patients to another 
provider less than 100 times during 
the reporting period.

This exclusion criteria is reported by self-attestation.
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CORE MEASURES CORE 15: SUMMARY OF CARE
Sending Referrals

 Progress Notes > Treatment > Outgoing Referral > Send Referral > Print, Print with attachment(s), Fax, or 
Fax with attachment(s)

 Progress Notes > Treatment > Outgoing Referral > green arrow next to the Send Referral button > Send 
Electronically
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Progress Notes > green arrow next to Fax button > Fax Consult Notes
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CORE MEASURES CORE 15: SUMMARY OF CARE
 T quick-launch link > Send eCW P2P Patient Record

 T quick-launch link > Send eCW P2P Referral/Consult
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing Referral > Send Referral > Print, Print with 
attachment(s), Fax, Fax with attachment(s), or green arrow next to the Send Referral button and Send 
Electronically
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Patient Hub > Referrals > Outgoing > New > Send Referral > Print, Print with attachment(s), Fax, Fax with 
attachment(s), or green arrow next to the Send Referral button and Send Electronically

Sending Referrals with Attachments

 T quick-launch link > Send eCW P2P Patient Record > Attachments > Send
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CORE MEASURES CORE 15: SUMMARY OF CARE
 T quick-launch link > Send eCW P2P Referral/Consult > Attachments or green arrow next to the Send 
Referral button and Send Electronically

 Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing Referral > Attachments > Send Referral or 
green arrow next to the Send Referral button and Send Electronically
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CORE MEASURES CORE 15: SUMMARY OF CARE
 Patient Hub > Referrals > Outgoing > New > Attachments > Send Referral or green arrow next to the Send 
Referral button and Send Electronically

Core 15-3

Measure

An EP must satisfy one of the following criteria:

 Conducts one or more successful electronic exchanges of a summary of care document, as part of which is 
counted in "measure 2" (for EPs the measure at §495.6(j)(14)(ii)(B) with a recipient who has EHR technology 
that was developed designed by a different EHR technology developer than the sender's EHR technology 
certified to 45 CFR 170.314(b)(2).

 Conducts one or more successful tests with the CMS designated test EHR during the EHR reporting period.

IMPORTANT!  No denominator/numerator calculations are required for this measure.  This measure is 
reported through self-attestation.

IMPORTANT!  For the electronic transmission of summary of care records (Core Measure 15), 
transactions must be sent to and from a Direct Address.  For more information, refer to Requesting a 
Direct Address.
Non-eCW providers can go to http://www.jointhenetwork.com to request an eClinicalWorks-issued 
Direct Address.
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CORE MEASURES CORE 15: SUMMARY OF CARE
To request a match to a CMS-designated test EHR:

1. Go to https://ehr-randomizer.nist.gov.

2. Click Register.

The Create Account page opens:

3. Fill out the fields here and click Create account.

4. Once your account is created, click Login in the top-right corner.

The Login pop-up window opens.

5. Enter your login information and click Login.

The EHR Randomizer Home Page opens.

6. Click My CEHRTs at the top of the page.
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CORE MEASURES CORE 15: SUMMARY OF CARE
The Manage CEHRTs page opens:

7. To create a CEHRT:

a. Enter a label of your choosing in the CEHRT Label field.

b. Enter the direct address issued to you by eClinicalWorks in the Direct Email Address field.

c. Select your time zone from the Time Zone pick list.

d. Select eClinicalWorks from the Developer pick list.

e. Click the No radio button in the Is your CEHRT member of Direct Trust section.

f. Click Save.

8. Click My Matches at the top of the page.

The My Matches page opens.
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CORE MEASURES CORE 15: SUMMARY OF CARE
9. Click Request New Match:

The Request a new match pop-up window opens:

10. Select the CEHRT for which you want to create a match from the Select CEHRT pick list.

11. Click Request match.
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CORE MEASURES CORE 15: SUMMARY OF CARE
Your match is generated:

You will receive an e-mail from your match with information on the next steps.  eClinicalWorks has already 
exchanged the necessary trust anchors with these CMS-designated test EHRs. 

12. Send a test referral during the preferred times for the following CMS-designated test EHRs:

Vendor Scheduling Testing Window Confirmation*

iPatientCare Scheduling is not 
required, but 
iPatientCare prefers 
that providers wait for 
their initial 
communication by e-
mail before sending a 
test.

 Monday 9:00 AM 
to 3:00 PM EST

 Wednesday 9:00 
AM to 3:00 PM 
EST 

Response is by e-mail and within 
the same day. 
Contact: Milan Kalola
Interoperability@iPatientCare.com

Medical 
Information 
Technology 
(Meditech)

Scheduling is not 
required, but 
Meditech prefers that 
providers send them a 
follow-up e-mail 
notifying them that a 
test was sent. 

 Monday 9:00 AM 
to 4:00 PM 

 Tuesday 9:00 AM 
to 4:00 PM

 Wednesday 9:00 
AM to 4:00 PM

 Thursday 9:00 
AM to 4:00 PM

Response is by e-mail, with a 
screenshot if successful. If the test 
is unsuccessful Meditech will 
respond with the reasons why so 
that the issue can be addressed. 
Contact: Philip Alcaidinho
onc-test-ehr-group@meditech.com
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CORE MEASURES CORE 15: SUMMARY OF CARE
13. On the day of the test, create a test patient in the eClinicalWorks EMR and check the following boxes on 
the Past Medical History, Medication Reconciliation, and Problem List windows:

McKesson† Scheduling is not 
required, but 
McKesson prefers that 
the test is sent within 
the given testing 
window.

 Monday 9:00 AM 
-to 4:00 PM EST

 Wednesday 9:00 
AM to 4:00 PM 
EST

 Thursday 9:00 
AM to 4:00 PM 
EST

Response is by e-mail and usually 
within the hour if sent during the 
testing window. McKesson 
welcomes follow-up calls and e-
mails from clients. 
Contact: Lori Fitzhugh
CMSCrossVendorExchange@mckess
on.com

*. This is the information provided on http://ehr-randomizer.nist.gov when this document was published. Please refer to that 
website for the latest information.

†. If you get McKesson when requesting a match, ensure you have selected No when you enter the information for MyCEHRT. 
Continue to request a match until you get iPatientcare or Meditech.

Vendor Scheduling Testing Window Confirmation*
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CORE MEASURES CORE 15: SUMMARY OF CARE
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CORE MEASURES CORE 15: SUMMARY OF CARE
14. To create an outgoing referral for this test patient:

a. Click More (...) next to the Provider field:

The Referring Physician Lookup window opens.

b. Select MA from the state pick list.

c. Enter Test in the search Name field.

Test names populate in the bottom pane.
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CORE MEASURES CORE 15: SUMMARY OF CARE
d. Click the radio button for your test referring physician (either Test EHR, iPatientCare; Test EHR, 
Meditech; or Test EHR, Mckesson):

e. Click Attachments on the Referral (Outgoing) window.

The Attachments window opens.
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CORE MEASURES CORE 15: SUMMARY OF CARE
f. Check the Attach Medical Summary box, the Attach CCR/CCD box, and the box next to the applicable 
Progress Notes:

g. Click OK.

15. Send the referral.

16. Reply to the e-mail you received when you requested a match from the CMS-designated test EHR, 
indicating that you sent a referral from "your direct address" on the date and time on which you sent the 
referral.

17. Receive a confirmation from the CMS-designated test EHR that they received the referral successfully.  Save 
this confirmation for audit purposes.
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CORE MEASURES CORE 16: SUBMITTING ELECTRONIC DATA TO IMMUNIZATION REGISTRIES
Exclusions

Providers may be excluded from this measure if they meet the following criteria:

Core 16: Submitting Electronic Data to Immunization 
Registries

Objective

Capability to submit electronic data to immunization registries or immunization information systems except 
where prohibited, and in accordance with applicable law and practice.

Measure

Successful ongoing submission of electronic immunization data from CEHRT to an immunization registry or 
immunization information system for the entire EHR reporting period.

Exclusion Criteria Area to Document within eClinicalWorks

They transfer patients to another 
setting or refer patients to another 
provider less than 100 times during 
the reporting period.

This exclusion criteria is reported by self-attestation.

Note:  Changes made in the Stage 2 Final Rule state that providers that use the same EHR technology 
and share a network for which their organization either has operational control of or license to use can 
conduct one test of the successful electronic exchange of a summary of care document with either a 
different EHR technology or the CMS-designated test EHR that covers all providers in their organization.  
For example, if a large group of EPs with multiple physical locations use the same EHR technology and 
those locations are connected using a network that the group has either operational control of or license 
to use, then a single test would cover all EPs in that group.
For more information, refer to https://questions.cms.gov/faq.php?faqId=7729.

Note:  At a minimum, you must register with your registry within the first 60 days of the start of the 
reporting period and follow their testing procedures.

IMPORTANT!  No denominator/numerator calculations are required for this measure. This measure is 
reported through self-attestation.
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CORE MEASURES CORE 16: SUBMITTING ELECTRONIC DATA TO IMMUNIZATION REGISTRIES
Exclusion

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Features Related to Core 16

The following features are related to Core Measure 16:

 Exporting Immunizations

Feature Area to Document within eClinicalWorks

Ongoing submissions originally 
achieved in a prior year using HL7 
2.3.1 that are continuing.

EMR > Immunizations/Therapeutic Injections > Immunizations 
Registry > Export Immunizations

A registration of intent within 60 
days of the beginning of the 
reporting period and meet at least 
ONE of the following criteria:
 Awaiting an invitation to begin 

testing. 
 Engaged in testing. 
 Ongoing submissions using 

HL7 2.5.1.

Contact your state immunization registry.

Note:  eClinicalWorks provides registry interfaces to practices in many 
states. The process details vary slightly based on individual state 
requirements. Contact eCW Support for more information about 
immunization registry interface for a specific state.

Exclusion Criteria Area to Document within eClinicalWorks

They do not administer any 
immunizations during the EHR 
reporting period.

This exclusion criteria is reported by self-attestation.

Their immunization registry does 
not provide timely information on 
their capacity to receive 
immunization data.

Their registry is not able to accept 
the HL7 2.5.1 standard.

Their registry is not enrolling new 
eligible providers on the HL7 2.5.1 
standard.
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CORE MEASURES CORE 17: USE SECURE ELECTRONIC MESSAGING
Exporting Immunizations

 EMR > Immunizations/Therapeutic Injections > Immunizations Registry > Export Immunizations

Core 17: Use Secure Electronic Messaging
Objective

Use secure electronic messaging to communicate with patients on relevant health information.

Measure

A secure message was sent using the electronic messaging function of CEHRT by more than 5 percent of unique 
patients (or their authorized representatives) seen by the EP during the EHR reporting period. 

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M
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Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy at least ONE of the following 
criteria:

Exclusion

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Numerator Criteria Area to Document within eClinicalWorks

They have sent any message from 
the Patient Portal to the provider 
during the EHR reporting period.

Record this information from the following locations:
 Admin band > Patient Portal Settings icon > Menu Settings > 

select Show from drop-down lists
 Patient Portal > Messages or Appointments

They have confirmed or canceled a 
voice appointment reminder 
message from the practice.

Configure options related to this measure from the following 
locations:
 Admin band > Messenger icon > Visit Status Mapping
 Admin band > Messenger icon > Voice Logs > select Appointment 

from the Message Type drop-down list
Record this information from the following locations:
 Practice band > Resource Scheduling icon > open an 

appointment > Visit Status
 Practice band > Provider Schedule icon > open an appointment > 

Visit Status

Note: For more information on how to use these features, refer to the 
eClinicalWorks Messenger Guide or the HelpHub. 

Exclusion Criteria Area to Document within eClinicalWorks

They have no office visits during 
the EHR reporting period

This exclusion criteria is reported by self-attestation.

They conduct 50 percent or more 
of their patient encounters in a 
county that does not have 50 
percent or more of its housing units 
with 3Mbps broadband availability, 
according to the latest information 
available from the FCC on the first 
day of the EHR reporting period.

This exclusion criteria is reported by self-attestation.
Information on broadband availability can be found at: http://
www.broadbandmap.gov/
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Features Related to Core 17

The following features are related to Core Measure 17:

 Recording Appointments

 Recording E&M Codes

 Configuring Patient Portal Menu Settings

 Sending Messages for Patients

 Configuring eClinicalWorks Messenger

 Recording Visit Status

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment
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Recording E&M Codes

 Progress Notes > Visit Code > Add E&M

Configuring Patient Portal Menu Settings

This is a one-time setup process:

 Admin band > Patient Portal Settings icon > Menu Settings > select Show from drop-down lists
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Sending Messages for Patients

Patients can send messages from the Patient Portal from the following location:

 Patient Portal > Messages or Appointments

Configuring eClinicalWorks Messenger

 Admin band > Messenger icon > Visit Status Mapping

 Admin band > Messenger icon > Voice Logs > select Appointment from the Message Type drop-down list
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Recording Visit Status

 Practice band > Resource Scheduling icon > open an appointment > Visit Status

 Practice band > Provider Schedule icon > open an appointment > Visit Status
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MENU SET MEASURES

3 of the following 6 objectives must be satisfied to fulfill the Meaningful Use requirements.

 Menu 1: Submitting Electronic Syndromic Surveillance

 Menu 2: Electronic Notes

 Menu 3: Imaging Results

 Menu 4: Family Health History

 Menu 5: Identify and Report Cancer Cases

 Menu 6: Specialized Registry

Selection Suggestion

 The two measures that most providers find the easiest to meet are:

 Menu 2: Electronic Notes

 Menu 4: Family Health History

 Providers should first see if they can claim an exclusion for all four remaining measures. If so, attest with 
the two measures listed above and claim an exclusion for any other measure.

 If exclusions cannot be claimed for all remaining measures, start with Menu 3: Imaging Results to see if you 
can meet that measure. If not, check with your state to see if they accept Syndromic Surveillance data. If 
they do, attest for Menu 1: Submitting Electronic Syndromic Surveillance. If they do not accept this data, 
attest for Menu 6: Specialized Registry.

 In cases where you cannot claim an exclusion from other Menu Set Measures and you are not able to meet 
them (e.g., you diagnose cancer and there is a cancer registry in your state but you cannot meet the 
measure as eCW is not supporting a cancer registry OR you have access to imaging results but are not able 
to meet the measure i.e., access imaging results from CEHRT), then you should satisfy this measure by 
registering your intent for on-going submission within the first 60 days of the reporting period with 
Dartnet.info.

For more information on Dartnet.info, refer to What is Dartnet.info?.

Note: While there are exclusions provided for some of the Menu Set objectives, users cannot select one 
of these objectives and claim the exclusion if there are other Menu Set objectives that they can report 
on instead.
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Menu 1: Submitting Electronic Syndromic Surveillance
Objective

Capability to submit electronic syndromic surveillance data to public health agencies except where prohibited, 
and in accordance with applicable law and practice.

Measure

Successful ongoing submission of electronic syndromic surveillance data from CEHRT to a public health agency 
for the entire EHR reporting period. 

Exclusions

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Note:  At a minimum, you must register with your registry within the first 60 days of the start of the 
reporting period and follow their testing procedures.

IMPORTANT!  No denominator/numerator calculations are required for this measure. This measure is 
reported through self-attestation.

Feature Area to Document within eClinicalWorks

Ongoing submissions originally 
achieved in a prior year using HL7 
2.3.1 that are continuing.

Each state has its own rules for syndromic surveillance. Please contact 
your state’s call center for more information. Open a support case to 
determine the scope and the cost of an interface with your chosen 
public health agency.

A registration of intent within 60 
days of the beginning of the 
reporting period and meet at least 
ONE of the following criteria:
 Awaiting an invitation to begin 

testing. 
 Engaged in testing. 
 Ongoing submissions using 

HL7 2.5.1.

Exclusion Criteria Area to Document within eClinicalWorks

They do not collect ambulatory 
syndromic surveillance information. 

This exclusion criteria is reported by self-attestation.

Their public health agency does not 
provide timely information on their 
ability to accept electronic 
submissions. 
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MENU SET MEASURES MENU 2: ELECTRONIC NOTES
Menu 2: Electronic Notes
Objective

Record electronic notes in patient records.

Measure

Enter at least one electronic Progress Notes created, edited, and signed by an EP for more than 30 percent of 
unique patients with at least one office visit during the EHR Measure reporting period. The text of the 
electronic note must be text searchable and may contain drawings and other content.

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Their public health agency is not 
capable of receiving electronic 
syndromic surveillance data.

Their public health agency capable 
of receiving electronic submissions 
is not able to add any providers to 
their enrollment.

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Exclusion Criteria Area to Document within eClinicalWorks
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Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy the following criteria: 

Features Related to Menu Set 2

The following features are related to Menu Set Measure 2:

 Recording Appointments

 Recording E&M Codes

 Recording Information in Progress Notes

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

Numerator Criteria Area to Document within eClinicalWorks

Their data is entered in at least 
ONE of the following sections of 
the Progress Notes (HPI, ROS, 
Treatment, or Procedures.

Record this information from the following locations:
 Progress Notes > HPI > select category > enter c/o, denies, 

duration, or notes
 Progress Notes > ROS > select category > enter presence or notes
 Progress Notes > Treatment > enter medications, labs, diagnostic 

imaging tests, procedures, outgoing referrals, or use eCliniSense
 Progress Notes > Procedures > select category > enter notes
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 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Recording E&M Codes

 Progress Notes > Visit Code > Add E&M

Recording Information in Progress Notes

 Progress Notes > HPI > select category > enter c/o, denies, duration, or notes
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 Progress Notes > ROS > select category > enter presence or notes
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MENU SET MEASURES MENU 2: ELECTRONIC NOTES
 Progress Notes > Treatment > enter medications, labs, diagnostic imaging tests, procedures, outgoing 
referrals, or use eCliniSense

 Progress Notes > Procedures > select category > enter notes
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MENU SET MEASURES MENU 3: IMAGING RESULTS
Menu 3: Imaging Results
Objective

Imaging results consisting of the image itself and any explanation or other accompanying information are 
accessible through CEHRT.

Measure

More than 10 percent of all tests whose result is one or more images ordered by the EP during the EHR 
reporting period are accessible through CEHRT.

Denominator

Patients are included in the denominator if they satisfy the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy at least ONE of the following 
criteria: 

Denominator Criteria Area to Document within eClinicalWorks

Their order date and result date are 
during the reporting period and 
they are marked as Received from 
the Diagnostic Imaging window.

Record this information from the following locations:
 Progress Notes > Diagnostic Imaging
 Progress Notes > Treatment > Browse in the Diagnostic Imaging 

section
 Telephone/Web Encounter > Labs/DI tab > Imaging > New
 Telephone/Web Encounter > Virtual Visit tab > Diagnostic 

Imaging
 Telephone/Web Encounter > Virtual Visit tab > Treatment > 

Browse in the Diagnostic Imaging section
 Patient Hub > DI > New

Numerator Criteria Area to Document within eClinicalWorks

A diagnostic image is attached to 
the test from the Document Details 
window.

Record this information from the following locations:
 Documents > Document Details > select a patient > open a 

document > Attached To
 Documents > Document Details > select a patient > open a 

document > Browse next to the Tag field > highlight the DI 
IMAGE tag > OK

IMPORTANT!  You must use DI IMAGE tag for this result to count in 
numerator for this measure.

Note:  There are no limitation on the resolution of the diagnostic 
image.

Note:  Diagnostic images and imaging results that are scanned into 
the CEHRT may be counted in the numerator for this measure.
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An indication that an image is 
accessible to the provider through 
the EHR is entered from the 
Diagnostic Imaging window

Record this information from the following locations:
 EMR > Labs/DI/Procedures > Diagnostic Imaging > highlight a DI 

and click Attribute Codes > New > Image Accessible
 L jellybean > Imaging > click a DI order > enter Y or Yes in the 

yellow row in the Image Accessible column
 Progress Notes > click a DI link under the Treatment heading > 

enter Y or Yes in the yellow row in the Image Accessible column
 Progress Notes > Diagnostic Imaging > click a DI link under the 

Diagnostic Imaging heading > enter Y or Yes in the yellow row in 
the Image Accessible column

 Progress Notes > right Chart Panel (ICW) > Labs/DI tab > click a 
DI > enter Y or Yes in the yellow row in the Image Accessible 
column

 Patient Hub > DI > click a DI order > enter Y or Yes in the yellow 
row in the Image Accessible column

 Telephone/Web Encounter > Labs/DI tab > Imaging > open a DI 
order > enter Y or Yes in the yellow row in the Image Accessible 
column

 Telephone/Web Encounter > Virtual Visit tab > click a DI link 
under the Treatment heading > open a DI order enter Y or Yes in 
the yellow row in the Image Accessible column

 Telephone/Web Encounter > Virtual Visit tab > click a DI link 
under the Diagnostic Imaging heading > enter Y or Yes in the 
yellow row in the Image Accessible column

IMPORTANT! To use the attribute workflow, the diagnostic image 
must be accessible through the EHR in some manner (scanned into 
documents, link to image within EHR, etc).

IMPORTANT! The attribute code must be entered as Image 
Accessible. The entry into the yellow grid under Image Accessible 
must either be Y or Yes for this result to count in the numerator for 
this measure.

A diagnostic imaging result with a 
link to the image (PACS Interface) is 
attached.

Documents > Document Details > select a patient > open a document 
> paperclick link (PACS Interface)

Numerator Criteria Area to Document within eClinicalWorks
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Exclusion

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Menu Set 3

The following features are related to Menu Set Measure 3:

 Recording Diagnostic Imaging Tests

 Attaching Diagnostic Imaging Tests

 Configuring the Diagnostic Image Tag

Recording Diagnostic Imaging Tests

 Progress Notes > Diagnostic Imaging

Exclusion Criteria Area to Document within eClinicalWorks

They have ordered less than 100 
tests whose result is an image 
during the EHR reporting period.

This exclusion criteria is reported by self-attestation.

They have no access to electronic 
imaging results at the start of the 
EHR reporting period.
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 Progress Notes > Treatment > Browse in the Diagnostic Imaging section

 Telephone/Web Encounter > Labs/DI tab > Imaging > New
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 Telephone/Web Encounter > Virtual Visit tab > Diagnostic Imaging

 Telephone/Web Encounter > Virtual Visit tab > Treatment > Browse in the Diagnostic Imaging section
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 Patient Hub > DI > New

Recording That an Image is Accessible

 EMR > Labs/DI/Procedures > Diagnostic Imaging > highlight a DI and click Attribute Codes > New > Image 
Accessible
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 L jellybean > Imaging > click a DI order > enter Y or Yes in the yellow row in the Image Accessible column

 Progress Notes > click a DI link under the Treatment heading > enter Y or Yes in the yellow row in the Image 
Accessible column

 Progress Notes > Diagnostic Imaging > click a DI link under the Diagnostic Imaging heading > enter Y or Yes 
in the yellow row in the Image Accessible column
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 Progress Notes > right Chart Panel (ICW) > Labs/DI tab > click a DI > enter Y or Yes in the yellow row in the 
Image Accessible column

 Patient Hub > DI > click a DI order > enter Y or Yes in the yellow row in the Image Accessible column

 Telephone/Web Encounter > Labs/DI tab > Imaging > open a DI order > enter Y or Yes in the yellow row in 
the Image Accessible column
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 179



MENU SET MEASURES MENU 3: IMAGING RESULTS
 Telephone/Web Encounter > Virtual Visit tab > click a DI link under the Treatment heading > open a DI 
order enter Y or Yes in the yellow row in the Image Accessible column

 Telephone/Web Encounter > Virtual Visit tab > click a DI link under the Diagnostic Imaging heading > enter 
Y or Yes in the yellow row in the Image Accessible column
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Attaching Diagnostic Imaging Tests

 Documents > Document Details > select a patient > open a document > Attached To

 Documents > Document Details > select a patient > open a document > paperclick link (PACS Interface)

 

AND
© Copyright eClinicalWorks, July 2015 - Meaningful Use Stage 2 Users Guide 181



MENU SET MEASURES MENU 3: IMAGING RESULTS
AND
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MENU SET MEASURES MENU 4: FAMILY HEALTH HISTORY
Configuring the Diagnostic Image Tag

 Documents > Document Details > select a patient > open a document > Browse next to the Tag field > 
highlight the DI IMAGE tag > OK

Menu 4: Family Health History
Objective

Record patient family health history as structured data.

Measure

More than 20 percent of all unique patients seen by the EP during the EHR reporting period have a structured 
data entry for one or more first-degree relatives.
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Denominator

Patients are included in the denominator if they satisfy the following criteria:

Numerator

Patients that satisfy the denominator are included in the numerator if they satisfy the following criteria: 

Denominator Criteria Area to Document within eClinicalWorks

They have had an outpatient 
appointment with a valid CPT* 
code created for them with an 
eligible professional during the 
reporting period.

*. CPT copyright 2014 American Medical Association. All rights reserved.

Record this information from the following locations:
 Practice band > Resource Scheduling icon > right-click on 

appointment slot > New Appointment
OR
Practice band > Provider’s Schedule icon > right-click on 
appointment slot > New Appointment

 Progress Notes > Visit Code > Add E&M

Numerator Criteria Area to Document within eClinicalWorks

Family history for one or more of 
their first-degree relative is 
recorded as structured data from 
the Family History window.

Record this information from the following locations:
 Progress Notes > Family History > Customize > Add
 Progress Notes > Family History > select the statuses of family 

members and enter any applicable diagnoses

Note:  A diagnosis for Unknown Family History also satisfies this 
measure and can be captured using the ICD code V49.89 or any 
dummy ICD code as long as it is mapped to SNOMED 407559004.
If there is no known family history for a patient, you can use any 
dummy ICD code and map it to SNOMED 160266009.

Note:  The following ICD and SNOMED-CT codes are available by 
default on V 10:
 250.00 (Diabetes) - 73211009
 401.9 (Hypertension) - 59621000
 429.9 (Heart Disease) - 56265001
 434.91 (Stroke) - 432504007
 310.9 (Mental Illness) - 192069009
 199.1 (Cancer) - 363346000
SNOMED-CT codes for various diagnoses can be looked up from here:
https://uts.nlm.nih.gov/snomedctBrowser.html
To use this browser, you must first register from here:
https://uts.nlm.nih.gov//license.html
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Exclusion

Providers may be excluded from this measure if they meet the following criteria:

Features Related to Menu Set 4

The following features are related to Menu Set Measure 4:

 Recording Appointments

 Recording E&M Codes

 Mapping ICD Codes with SNOMED Codes

 Recording Family History

Recording Appointments

 Practice band > Resource Scheduling icon > right-click on appointment slot > New Appointment

 Practice band > Provider’s Schedule icon > right-click on appointment slot > New Appointment

Exclusion Criteria Area to Document within eClinicalWorks

They have no office visits during 
the EHR reporting period

This exclusion criteria is reported by self-attestation.
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Recording E&M Codes

 Progress Notes > Visit Code > Add E&M

Mapping ICD Codes with SNOMED Codes

 Progress Notes > Family History > Customize > Add

Recording Family History

 Progress Notes > Family History > select the statuses of family members and enter any applicable diagnoses
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MENU SET MEASURES MENU 5: IDENTIFY AND REPORT CANCER CASES
Menu 5: Identify and Report Cancer Cases
Objective

Capability to identify and report cancer cases to a public health central cancer registry, except where 
prohibited, and in accordance with applicable law and practice.

Measure

Successful ongoing submission of cancer case information from CEHRT to a public health central cancer registry 
for the entire EHR reporting period. 

IMPORTANT! No denominator/numerator calculations are required for this measure. This measure is 
reported through self-attestation.

Note: eClinicalWorks Version 10 is a 2014 CEHRT complete EHR and has chosen not to certify for this 
Menu Set measure as it was optional for certification. Providers that diagnose cancer in a state that 
accepts cancer data, should report on one of the following measures:
 Menu 1: Submitting Electronic Syndromic Surveillance
 Menu 3: Imaging Results
 Menu 6: Specialized Registry

Feature Area to Document within eClinicalWorks

Ongoing submissions originally 
achieved in a prior year that are 
continuing.

Contact your state registry.

A registration of intent within 60 
days of the beginning of the 
reporting period and meet at least 
ONE of the following criteria:
 Awaiting an invitation to begin 

testing. 
 Engaged in testing. 
 Ongoing submissions

In cases where you cannot claim an exclusion from other Menu Set 
Measures and you are not able to meet them (e.g., you diagnose 
cancer and there is a cancer registry in your state but you cannot 
meet the measure as eCW is not supporting a cancer registry OR you 
have access to imaging results but are not able to meet the measure 
i.e., access imaging results from CEHRT), then you should satisfy this 
measure by registering your intent for on-going submission within the 
first 60 days of the reporting period with Dartnet.info.
For more information on Dartnet.info, refer to What is Dartnet.info?.

Note:  At a minimum, you must register with your registry within 60 
days of the start of your reporting period and follow their testing 
procedures.
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MENU SET MEASURES MENU 6: SPECIALIZED REGISTRY
Exclusions

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Menu 6: Specialized Registry
Objective

Capability to identify and report specific cases to a specialized registry (other than a cancer registry), except 
where prohibited, and in accordance with applicable law and practice.

Measure

Successful ongoing submission of specific case information from CEHRT to a specialized registry for the entire 
EHR reporting period.

Exclusion Criteria Area to Document within eClinicalWorks

They do not diagnose or directly 
treat cancer. 

This exclusion criteria is reported by self-attestation.

They operate in a jurisdiction for 
which no public health agency is 
capable of receiving electronic 
cancer case information in the 
specific standards required for 
CEHRT at the beginning of their 
EHR reporting period.

They operate in a jurisdiction 
where no PHA provides information 
timely on capability to receive 
electronic cancer case information.

They operate in a jurisdiction for 
which no public health agency that 
is capable of receiving electronic 
cancer case information in the 
specific standards required for 
CEHRT at the beginning of their 
EHR reporting period can enroll 
additional EPs.

IMPORTANT! No denominator/numerator calculations are required for this measure. This measure is 
reported through self-attestation.
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Providers must attest Yes to successfully submitting specific case information from CEHRT to a specialized 
registry for the entire reporting period to meet this measure. In order to attest Yes, Providers must meet ONE 
of the following criteria:

Criteria Action

An ongoing submission has already 
been achieved for an EHR reporting 
period in a prior year and continues 
throughout the current EHR 
reporting period.

 Identify if your state or national specialty society has a 
specialized registry.

 If your state has a specialized registry, you must register your 
intent within the first 60 days of the reporting period.

 If your state does not have a specialized registry, please verify 
with your national specialty society to see if they have or are 
sponsoring a specialized registry. If so, register your intent within 
the first 60 days of the reporting with Dartnet.info (as this is our 
preferred registry).

 If neither your state nor your specialty society has a specialized 
registry, you can claim an exclusion.

 In cases where you cannot claim an exclusion from other Menu 
Set Measures and you are not able to meet them (e.g., you 
diagnose cancer and there is a cancer registry in your state but 
you cannot meet the measure as eCW is not supporting a cancer 
registry OR you have access to imaging results but are not able 
to meet the measure i.e., access imaging results from CEHRT), 
then you should satisfy this measure by registering your intent 
for on-going submission within the first 60 days of the reporting 
period with Dartnet.info.
For more information on Dartnet.info, refer to What is 
Dartnet.info?.

A registration with the PHA (or 
other body to whom the 
information is being submitted) of 
intent to initiate ongoing 
submission was made by the 
deadline (within 60 days of the 
start of the EHR reporting period) 
and ongoing submission was 
achieved. 

A registration of intent to initiate 
ongoing submission was made by 
the deadline and the EP or hospital 
is still engaged in testing and 
validation of ongoing electronic 
submission.

A registration of intent to initiate 
ongoing submission was made by 
the deadline and the EP or hospital 
is awaiting an invitation to begin 
testing and validation.
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MENU SET MEASURES MENU 6: SPECIALIZED REGISTRY
Exclusions

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks

They do not diagnose or directly 
treat any disease associated with a 
specialized registry sponsored by a 
national specialty society for which 
the EP is eligible, or the public 
health agencies in their jurisdiction.

This exclusion criteria is reported by self-attestation.

They operate in a jurisdiction for 
which no specialized registry 
sponsored by a public health 
agency or by a national specialty 
society for which they are eligible is 
capable of receiving electronic 
specific case information in the 
specific standards required by 
CEHRT at the beginning of their 
EHR reporting period.

They operate in a jurisdiction 
where no public health agency or 
national specialty society for which 
they are eligible provides 
information in a timely manner on 
their capability to receive 
information into their specialized 
registries.

They operate in a jurisdiction for 
which no specialized registry 
sponsored by a public health 
agency or by a national specialty 
society for which they are eligible is 
capable of receiving electronic 
specific case information in the 
specific standards required by 
CEHRT at the beginning of their 
EHR reporting period can enroll 
additional providers.
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What is Dartnet.info?

The DI Practice Performance Registry compiles and processes EHR data in order to provide a graphical view of 
how organizations and practices are doing on specific measures and how they compare to other organizations/
practices.

The DI Practice Performance Registry has been endorsed by the American Academy of Family Physicians as a 
Quality Improvement Registry. It also meets Stage 2 Meaningful Use Menu Set Measure 6 requirements, 
specifically: Successful ongoing submission of specific case information from a certified EHR technology to a 
specialized registry for the entire EHR reporting period.

Contact them by e-mail at DIRgistry@dartnet.info to register your intent.

For providers reporting for Q4, the deadline to register their intent is 26th Nov. The process takes several days 
to complete, so initiate them at the earliest.
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MEANINGFUL USE STAGE 2 AUDIT TOOLKIT

This document provides suggestions for eClinicalWorks clients to prepare for a potential Meaningful Use audit.  
Auditors may need more information on a case-by-case basis. In such circumstances, contact eClinicalWorks 
Support for additional assistance.

Meaningful Use Audits
Providers who receive an EHR incentive payment for Stage 2 of the Medicare or Medicaid EHR Incentive 
Program may potentially be subject to an audit.  Eligible professionals (EPs) and eligible hospitals should retain 
all relevant supporting documentation (in either paper or electronic format) used in the completion of the 
Attestation Module responses. 

Documentation to support attestation data for Stage 2 Meaningful Use objectives and Clinical Quality Measures 
(CQMs) should be retained for six years post-attestation. 

Overview of Meaningful Use in 2015
Regardless of the stage/year of MU, EPs must demonstrate MU for a three-month period on 2015.

Medicare EPs beyond their first year must attest a Calendar Quarter- Q1, Q2, Q3, or Q4

Medicaid EPs must attest any 90 days in 2014.

To document proof of compliance for percentage-based measures:

1. As proof of use of a Certified Electronic Health Record Technology system, provide invoices or a copy of 
your licensing agreement with the vendor. Please ensure that the licensing agreements or invoices identify 
the vendor, product name, and product version number of the Certified Electronic Health Record 
Technology system utilized during your attestation period. If the version is not present on the invoice/
contract, please supply a letter from your vendor attesting to the version number used during your 
attestation period.

Request an EHR verification letter by opening a case with eClinicalWorks Support. Indicate the reporting 
period, stage on which you are reporting, and the number of providers on which you are reporting:
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2. Provide a response to the following questions:

a. At how many offices or other outpatient facilities do you see your patients?

b. List each office or other outpatient facility where you see patients and indicate whether or not you 
utilize Certified Electronic Health Record Technology in each office or other outpatients facility:

c. If you utilize more than one office or other outpatient facility, supply documentation which proves that 
50% or more of your patient encounters during the EHR reporting period have been seen in offices or 
outpatient facilities where you utilize a CEHRT system.

d. Do you maintain any patient records outside of your CEHRT system?

If yes, supply documentation which proves that more than 80% of the medical records of unique 
patients seen during the attestation period are maintained in a CEHRT system at each office or other 
outpatient facility where CEHRT system is being used.

# Office or Other Outpatient Facility Utilize CEHRTS?

1

2

3
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Core Measures
Use the following workflow suggestions to document proof of compliance for self-attestation measures.  All 
necessary screenshots should be taken three times: at the beginning, middle, and end of the reporting period.

The following self-attestation Core Measures are covered in this document:

 Attesting to Core Set Objectives

 Protect Electronic Health Information

 Generate Lists of Patients by Specific Conditions

 Exchange Summary of Care Record at Each Transition of Care to EP on Another CEHRT or with a CMS-
Designated EHR

 Capability to Submit Electronic Data to Immunization Registry

 Clinical Decision Support Rule

Attesting to Core Set Objectives

For Core Measures # 1, 2, 3, 4, 5, 7, 8, 10, 12, 13, 14, 15 (1 and 2), and 17 provide the supporting 
documentation (in either paper or electronic format) used in the completion of the Attestation Module 
responses (e.g., a report from your EHR system that ties to your attestation). This documentation should 
include the numerator and denominator for each measure, as well as the date range and the EP's name or NPI.

To document proof of compliance for percentage-based measures:

1. From the MAQ Dashboard, click Stage 2 in the left pane, then click Core.

2. From the Select View pick list, click Score Card:

OR

Note: If you are providing a summary report from your EHR system as support for your numerators/
denominators, please ensure that we can identify that the report has actually been generated by your 
EHR (e.g., your EHR logo is displayed on the report, or step-by-step screenshots which demonstrate how 
the report is generated by your EHR are provided).
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If data for previous years is required, click Historic View.

3. Click Period A or Period B to open the Select Any One Period window and select a time period:

4. Export the data to a PDF by clicking the floppy disk icon to open a drop-down list, then clicking Save as PDF:

5. Save the file on your desktop.

A message displays confirming that the file was saved successfully:

In the file that is saved on your computer, pages 1 and 2 display the Core Measures for the practice:
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Pages 3 and 4 display the Core Measures for the selected provider:
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Protect Electronic Health Information 

For this measure, you will need to provide documentation to CMS proving that you completed a security risk 
analysis (SRA).  When you perform your SRA you should have a checklist of things to complete for it.  Keep a 
copy of this checklist report.

Security attributes, Rx security, P.S.A.C. categories and permissions, authentication settings, admin logs, 
confidential Progress Notes, and confidential patient accounts are available from eClinicalWorks to satisfy this 
measure. For more information on how to use these features, refer to the System Administration Users Guide 
or the HelpHub.

Generate Lists of Patients by Specific Conditions

1. From the Registry band, click Registry Reports.

The Registry Reports List window opens.

2. Check the box next to the saved report and click Run Report (Excel):

The report is exported to an Excel spreadsheet.  Keep a copy of this report.

If you are using the Analyze Data button in the Registry dashboard:

1. When the report is run, click Analyze Data:

The eClinicalWorks Viewer window opens.

Note:  Regardless of whether a practice is locally hosted or hosted in the cloud, a Security Risk 
Assessment must be conducted
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2. Click Print: 

Exchange Summary of Care Record at Each Transition of 

Care to EP on Another CEHRT or with a CMS-Designated EHR 

As part of Meaningful Use Stage 2's Transition of Care measure eligible professionals (EPs) and eligible 
hospitals/critical access hospitals (CAHs) are required to perform one of the following actions: 

 Conduct one or more successful electronic exchanges of a summary of care document, with a recipient who 
has EHR technology designed by a different EHR technology developer than the sender's. 

 Conduct one or more successful tests with the CMS-designated test EHR during the EHR reporting period

The EHR Randomizer supports the testing of exchanges with a designated test EHR.  If you successfully 
exchanged a Summary of Care document with at least one provider with a different EHR than yours and 
documented that exchange, you do not need to use this website for the test exchange measure. 

For support and assistance, post a message on the ehr-randomizer group.
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Perform one of the following actions to collect the require documentation to demonstrate that you have met 
this requirement:

 Exchange a Summary of Care by a referral through P2P (including CCR/CCD):

 Exchange a Summary of Care with a different EHR than the one they are using for Meaningful Use.

Keep documentation for your records when you send a Summary of Care record to a provider that is using 
a different EHR.

You should receive an e-mail within 24 hours after the registration process from the test EHR indicating that 
the test was successful.  Once you receive confirmation that the CCDA was received, you have successfully 
completed your test.
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Capability to Submit Electronic Data to Immunization 

Registry 

Some practices may be exempt from this measure.

If your state has an immunization interface with eClinicalWorks:

1. From the File menu, click Interface Dashboard:

The Interface Dashboard window opens.

2. Click the Immunizations tab at the top of the window.

The Immunizations options display.

3. Click the Outbound tab on the left side of the window.

4. Information on immunizations sent from this system displays:
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OR

 If the data submissions failed through the Immunization interface, take a screenshot of this failed 
submission.

 If you submitted a test HL7 file, provide documentation from your state that your test was successful or 
unsuccessful.

 If you were unable to submit an HL7 file due to a state unavailability discrepancy, request documentation 
for this from your state.

 If your state registry is on a different HL7 standard than eClinicalWorks’ and you were not able to send a 
test file, contact eClinicalWorks Support and we will provide you a letter stating that we currently only offer 
HL7 version 2.5.1.

Clinical Decision Support Rule

Measure 1: CDSS Alerts

If you are meeting five (5) measures related to four (4) or more CDSS alerts:

1. To document how the CDSS alerts are set up:

a. From the EMR menu, hover over CDSS and click Measure Configuration.

Note: If it is necessary to go back further than one month, please contact eClinicalWorks Support to 
obtain logs showing that data.

Note: Only the data for the last month is displayed on the Immunization Dashboard. Any 
immunization from one to six months old is archived, for which we do not have access.
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The Measure Configuration window opens:

b. Take a screenshot of this window.

2. To take screenshots of the CDSS alerts within the Patient Dashboard:

a. Open a patient's Progress Notes for an encounter taking place during the attestation period.

b. Click the CDSS link in the Patient Dashboard:
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The CDSS Alerts window opens:

c. Take a screenshot of this window.

3. To document the CDSS alerts within the Office Visit:

a. Open a patient's Progress Notes for an encounter taking place during the attestation period.

b. Click the CDSS tab in the right Chart Panel (ICW):

c. Take a screenshot of this tab.

Measure 2: Drug/Drug and Drug/Allergy Interaction Check

Documentation for Measure 170.304(a) is different for Multum® and Medi-Span® drug databases.  First, 
determine which drug database the practice is using, and then use the appropriate procedure to document this 
measure.
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To determine which drug database the practice is using:

1. From the Progress Note, and click Treatment.

The Treatment window opens.

2. Click Add:

The Manage Orders window opens:

3. From the Type pick list, check for one of the following options:

 Multum Rx

 Medispan Rx

The option that displays is the drug database that the practice uses.
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Multum Drug Database

To document 170.304(a) if the practice uses the Multum Drug Database:

1. From the Progress Note, click Treatment:

The Treatment window opens.

2. Click Interactions:
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The Drug Interaction window opens:

Take a screenshot of this window at the beginning, middle, and end of the reporting period.
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Medi-Span Drug Database

To document 107.304(a) if the practice uses the Medi-Span Drug Database:

1. From the Reports menu, point to EMR, then click Drug Interaction Logs.

The Drug Interaction Log Report window opens:

2. Select the appropriate user from the User pick list.

3. Click More (...) next to the From Date and To Date fields to open pop-up calendars and select a date range.

The report runs automatically when you make changes to these filter fields.

Menu Set Measures
In 2014, EPs cannot select a Menu Set Measure and claim exclusion for it if there are other Menu Set Measures 
they can meet.  The following Menu Set Measures are covered in this document:

 Capability to Submit Electronic Syndromic Surveillance Data to Public Health Agencies

 Capability to Identify and Report Cancer Cases to a Public Health Central Cancer Registry

 Capability to Identify and Report Specific Cases to Specialized Registry (Other than a Cancer Registry)

Attesting to Measure Set Measures

If attested to Menu Set Measures # 2, 3, or 4, provide the supporting documentation (in either paper or 
electronic format) used in the completion of the Attestation Module responses (e.g., a report from your EHR 
system that ties to your attestation). This documentation should include the numerator and denominator for 
each measure as well as a date range and the EP's name or NPI.

To document proof of compliance for percentage-based measures:

1. From the MAQ Dashboard, click Stage 2 in the left pane, then click Menu.

Note: If you are providing a summary report from your EHR system as support for your numerators/
denominators, please ensure that we can identify that the report has actually been generated by your 
EHR (e.g., your EHR logo is displayed on the report, or step-by-step screenshots which demonstrate how 
the report is generated by your EHR are provided).
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2. Export the data to a PDF by clicking the floppy disk icon to open a drop-down list, then clicking Save as PDF:

3. Save the file on your desktop.

A message displays confirming that the file was saved successfully.

In the file that is saved on your computer, page 1 displays all the Menu Set measures for your practice:
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Page 2 displays the Menu Set Measures for a specific provider:

Capability to Submit Electronic Syndromic Surveillance Data 

to Public Health Agencies

If you submitted a test HL7 file, provide documentation from your state that your test was successful or 
unsuccessful.

If you were unable to submit an HL7 file due to a state unavailability discrepancy, request documentation for 
this from your state.

If eClinicalWorks is on a different HL7 format than your state registry and you were not able to send your test 
file, contact eClinicalWorks Support and we will provide you a letter stating that we currently only offer HL7 
version 2.5.1.

Capability to Identify and Report Cancer Cases to a Public 

Health Central Cancer Registry

eClinicalWorks Version 10 is a 2014 CEHRT complete EHR and has chosen not to certify for this measure as it 
was optional for certification.
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Capability to Identify and Report Specific Cases to 

Specialized Registry (Other than a Cancer Registry)

eClinicalWorks Version 10 is a 2014 CEHRT complete EHR and has chosen not to certify for this measure as it 
was optional for certification.

CQMs
There are two recommended core sets of CQMs, one for adults, and one for children that focus on high-priority 
health conditions and best practices for care delivery.

Take a screenshot of the MAQ Dashboard with the CQM data displayed, ensuring that a zero is displayed in the 
denominator for each measure (or include documents for which the provider qualifies for an exclusion):
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Medicaid Meaningful Use
In addition to all the aforementioned requirements, Medicaid attestation requires the Patient Encounter 
Report.  Since eClinicalWorks can only generate the number of patients seen using the eClinicalWorks 
application, if any patient was seen using paper chart or at another facility, that number must be manually 
added to the denominator.  If the practice has used the eClinicalWorks application only, the numerator would 
match the denominator for both of the following reports.

Patient Encounter Report

50% of All Patient Encounters Occurred at a Facility Using Certified EHR Technology

Use the denominator of the Clinical Visit Summaries (encounter - New MU Spec) to get the numerator of this 
report.

80% of All Unique Patient Encounters Occurred at a Facility Using Certified EHR Technology 

Use the denominator of Record Demographics/Active Medication List/Active Medication Allergy List to get the 
numerator of this report.

Additional Tips
Throughout a Meaningful Use Stage 2 audit, keep the following tips in mind:

 If you have referred to any FAQ from http://questions.cms.gov, keep a copy of that FAQ document.

 Provide supporting documentation for all claimed exclusions.

 Print the PDF Summary at the end of attestation and keep it on file.

 When sending the screenshots to the auditors, black out any identifiable patient health information.  If this 
is not possible, use secure messaging to send the screenshots.  Ensure that all data sharing with the 
auditors is HIPAA compliant.  

For more information about HIPAA compliance, visit: http://www.hhs.gov/ocr/privacy/

IMPORTANT!  These are state-specific requirements.  Practices should check with their states for specific 
Medicaid Meaningful Use requirements.
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OUTPATIENT

APPENDIX A: LIST OF OUTPATIENT CODES

The following is a list of codes that satisfy the objective measures that require a patient to be seen by the EP.

Outpatient
92004, 92002, 92014, 92012, 99024, 99211, 99212, 99213, 99214, 99215, 99201, 99202, 99203, 99204, 99205, 
99241, 99242, 99243, 99244, 99245, 99324, 99325, 99326, 99327, 99328, 99334, 99335, 99336, 99337, 99341, 
99342, 99343, 99344, 99345, 99347, 99348, 99349, 99350, 99381, 99382, 99383, 99384, 99385, 99386, 99387, 
99394, 99395, 99396, 99397, 99420, 99429, 99455, 99456, 90846, 90847, 90853, 90857, 90801, 90804, 90805, 
90806, 90807, 90808, 90809, 90802, 90810, 90811, 90812, 90813, 90862, 90960, 90961, 90962, 90966, 90970, 
G0438, G0439, G0402, D0120, D0140, D0150, 99304, 99305, 99306, 99307, 99308, 99309, 99310, 99315, 
99316, 99318, 99391, 99392, 99393, 99356, 99324, 99325, 99326, 99327, 99334, 99335, 99336, 99337, D0120, 
D0140, D0145, D0150, D0160, D0170, D0180, D1110, D1120, 98940, 98941, 98942, 98943, MUOBV, MUREP, 
90785, 90791, 90792, 90832, 90833, 90834, 90836, 90837, 90838, 99495, 99496
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APPENDIX B: NOTICES

Trademarks
eClinicalWorks®

eClinicalMobile® 

eClinicalMessenger®

eClinicalWorks P2P® 

eClinicalWorks, eClinicalMobile, 
eClinicalMessenger, and eClinicalWorks P2P are 
registered trademarks of eClinicalWorks, LLC.  

All other trademarks or service marks contained 
herein are the property of their respective 
owners.

Current Procedural Terminology (CPT®*)

CPT is a registered trademark of the American 
Medical Association.

Surescripts®

Surescripts is a registered trademark.

All other trademarks or service marks contained 
herein are the property of their respective 
owners.

SNOMED®

SNOMED CT®

SNOMED® and SNOMED CT® are registered 
trademarks of the International Health 
Terminology Standards Development 
Organization.

Copyright
CPT Copyright Notice  

CPT copyright 2014 American Medical 
Association. All rights reserved.

Fee schedules, relative value units, conversion 
factors and/or related components are not 
assigned by the AMA, are not part of CPT, and 
the AMA is not recommending their use.  

The AMA does not directly or indirectly practice 
medicine or dispense medical services.  The AMA 
assumes no liability for data contained or not 
contained herein.

*. CPT copyright 2014 American Medical Association. All rights 
reserved.
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